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Preface
"Your intranet should bring daily value to employees - then you have a healthy
and thriving intranet community." - Bill Rogers, Ektron CEO
A compelling intranet site can be challenging to develop. To meet the needs of
the individuals and departments of your company, there are many factors you
need to consider to address the complexity and usefulness of an intranet. A
company changes as it grows; competition, expansion, or geographic changes
mean that you need an agile and quickly modifiable intranet that will adjust
with you.
Ektron has studied the needs of customers like you and is using its own
experience with intranets, and using Best Practices for Navigation and clear
content styles. Ektron eIntranet reduces the stress of building and deploying an
intranet site by providing pre-built web pages for you that you can customize
easily.
You can boost productivity, raise employee morale, and improve a company's
bottom line with an effective intranet. Communication and collaboration in a
company improves with intranets that are compelling and timely.
Ektron eIntranet gives you the confidence that you can adapt and deploy your
intranet securely and easily.
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Chapter 1

Getting Started with Ektron
eIntranet
The Ektron eIntranet is built on Ektron's powerful CMS400.NET.
What do you get with Ektron eIntranet?
The Ektron eIntranet site is ready to use with pages, templates, and easy
customization. The Ektron eIntranet comes with the following:
eIntranet
Area

Description

Home Page

The Ektron eIntranet home page displays dynamic up-to-date content
from many sources of information, making it valuable for daily use.
You can easily move, add, and delete this content using Ektron's PageBuilder technology, literally dragging and dropping the content
wherever you want it.

Department
Landing Pages

Manage content that is important to your departmental functions.
Ektron eIntranet comes preloaded with department landing pages.
You can add, change, or delete departments to match your organization.

Employee Resources

Give your people one area to find forms, policies, office and building
maps, newsletters, and social networking forums. Ektron eIntranet
lets you customize your human resources area to fit your company's
needs.

News and Events

Keep the members of your intranet informed about industry news,
special events, messages from the CEO and management. As your
colleagues add new content, they automatically display in the news
list.

My Intranet

Lets you customize your profile and settings to deliver content that is
important to you and your job.
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eIntranet
Area

Description

Over 50 types of widgets that you can drag and drop
onto your Ektron eIntranet site pages.
Social media functionality for users and groups.
Additional features

Secure login credentials through your current network
authorization with Active Directory and LDAP, or
through your own list of users.
Group privacy and distribution functions.
Micro-messaging notification system to email, cell
phones (SMS), and on-page activity streams.

Priority space "above the fold" is for attractive design, easy-to-recognize menu
and search navigation, and other links.
What can Ektron eIntranet do?
The Ektron eIntranet is ready to customize for your
organization, using easy-to-use yet powerful PageBuilder
technology. You can choose from several page templates
and drag and drop blocks of functional content called
widgets onto the page. Some widgets are so flexible, you
can put what you want in them and display them at
specified times or conditions.
The Ektron eIntranet lets you post the following:
Time-specific information such as upcoming events, activity streams,
news, and announcements are easy to spot.
A "Photo Of The Day" calls attention to important achievements,
events, or people in your company.
The CEO's blog keeps a direct line of communication with all employees.
Quick Reference Links and Phone Book block provide reference to
important or often-needed information.
Twitter feeds also may be important to you to quickly hear from your
customers and your market.
Ektron's standard widgets include CMS400.NET functionality such as
Content, Search, Collections, and Blogs, and also many popular widgets like YouTube, Twitter, FaceBook, and more.
What benefits can my organization get from Ektron eIntranet?
The Ektron eIntranet is ready to help you and your employees achieve common
business goals and increase operational efficiency by connecting your
employees and growing your knowledge base through a collaborative and
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productive network.
Enable your employees to share their knowledge and experience with
others in your company.
Establish collaborative project and social groups that provide open
and accurate communication that is timely and relevant.
Post and display your activities, activities of your colleagues, and the
activities of project or interest groups through on-page activity
streams, Twitter feeds, RSS feeds, or email notification, which you
can customize in your profile settings.
Enable blogging for more extensive management communication or
human interest stories.
Provide access to documentation, photos, forms, and other assets.
You can control access to individuals, to groups, or to everyone.
Ektron eIntranet Requirements:
Because this site is a powerful intranet for use inside firewalls, privileges are
determined for each CMS400.NET user. Membership user functionality is not
included for the Ektron eIntranet site.
Only CMS400.NET users have access to the Ektron eIntranet site.
Aliasing is enabled by default. Do not disable aliasing because it will
cause errors in department pages.
Do NOT delete the Settings content block at Workarea > Content >
Folders > Setup in CMS400.NET.
Do NOT delete the Settings Smartform.
You must maintain the taxonomy and folder structure.
You can find online help anywhere you see and click the help icon (

).

For complete information about Ektron's CMS400.NET,
see the Ektron CMS400.NET Reference Manual.
For the latest versions of Ektron documentation, go to
http://www.ektron.com/documentation/
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Touring the Home Page
The default Ektron eIntranet home page contains information and features that
employees need daily. The following figure shows the default home page with
each page section outlined for easier identification. A widget icon further
identifies the type of widget used to create the content on the page.

The following table describes each of the blocks in the figure.
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Block & Widget Used

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet site. You
can log in to page edit mode, view the site map, and go to the Welcome Guide page. After you log in, you also can add a department
page and enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages, Employee
Resources, News and Events, and your personal space on My Intranet.

Launches the eIntranet online help: Getting Started with Ektron eIntranet.

Upcoming Events
Communicate important dates and events scheduled on the
Company Calendar. The list of events is ordered from your next
upcoming event to later events.. For information about its properties,
see eI_UpcomingEvents Widget on page 203. See also Displaying
Upcoming Events on page 65.

Quick Reference
Create links to important or often-used content that you want
accessible to all people from the home page using the eI_Collection
widget . For information about its properties, see eI_Collection Widget
on page 176. see also Adding Links to the Quick Reference Collection
Widget on page 74.

Phone Book
Display important phone numbers you want accessible to everyone
from the home page using the eI_ContentBlock widget. For information about its properties, see eI_ContentBlock Widget on page
180. See also Changing the Contents of the Phone Book on page 75.
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Block & Widget Used

Function

Photo of the Day
Add a photo to the Photo Of The Day to highlight a story or event, or
recognize outstanding contributions from your work force, using the
eI_PhotoOfTheDay widget. You can add a caption, print, or email the
photo. For information about its properties, see eI_PhotoOfTheDay
Widget on page 194. See also Changing the Photo of the Day on
page 67.

From the CEO's Blog
See the latest Blog from the CEO on the home page using the eI_
RecentBlogPosts widget. When the CEO creates a new entry in this
blog, this teaser appears on the front page. For information about its
properties, see eI_RecentBlogPosts Widget on page 197. See also
Adding Entries to the CEO's Blog on page 78.

News

Announcements

Activity Stream

Display news items that affect your organization using the eI_
ListSummary widget. In this case, the items are News type content
with the newest entry at the top. You can choose to automatically
scroll the content. For information about its properties, see eI_
ListSummary Widget on page 185. See also Displaying News Items
on page 83.

Display announcements to your organization using the eI_
ListSummary widget. In this case, the items are text entry type with the
newest announcements at the top. You can choose to automatically
scroll the content. For information about its properties, seeeI_
ListSummary Widget on page 185. see also Creating and Displaying
Announcements on page 80.

Display the activity of people and groups in your Ektron eIntranet with
whom you have connected using the eI_ActivityStream widget . You
can choose the types of information you want to see from your
colleagues and groups, such as blogs, comments, micro-messaging
status, and so on. For information about its properties, see eI_
ActivityStream Widget on page 171. See also Customizing the Activity
Stream on page 70.

Twitter
Display news and content from outside your organization using the
TwitterFeed widget. Keep in touch with what customers and others
are saying about your product and services by setting the feed to
show Tweets that are related to your company or industry.

6

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Touring the Default Department Pages
The Ektron eIntranet comes with the following default department pages.
Departments > Engineering below
Departments > Marketing on page 10
Departments > Human Resources on page 13
Departments > Sales on page 16
Departments > Training on page 19
For information about managing department pages, see the following:
To create a new department, see Creating a New Department Landing
Page on page 90.
To modify an existing department page, see Modifying an Existing
Department Page on page 90.
To delete an existing department page, see Deleting a Department
from the eIntranet Site on page 92.
Tasks for modifying department pages are similar to modifying the home page,
which is described in Editing the Default Home Page on page 64.
Task

Section

Add or delete members from the group

Adding Members to a Restricted Group on page 131

Add content to News

Displaying News Items on page 83

Add events to Upcoming Events

Displaying Upcoming Events on page 65

Customize the Activity Stream

Customizing the Activity Stream on page 70

Add assets to the Collateral

Adding Assets to the Intranet on page 97

Add blog entries to the blog

Adding Entries to the CEO's Blog on page 78

Departments > Engineering
The default Ektron eIntranet Engineering department page contains information
and features that are related to engineering activity, such as release build
announcements, members in the Engineering organization, new feature
requests, and activity in the department.The following figure shows the default
Engineering page.
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add or delete a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the eIntranet
site. The breadcrumb in the figure indicates that it is the Engineering department home page. Breadcrumbs also are navigation links. You can click Home to go to the home page, or
other links on the breadcrumb trail to go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Members

Engineering News

Upcoming Engineering
Events

Activity Stream

Displays the members of the Engineering department. This
content block uses the eI_CommunityGroupMembers widget
to show members in a community group. Administrators can
add, remove, and invite others to the group. For information
about its properties, see eI_CommunityGroupMembers
Widget on page 178.

Displays news items that affect the Engineering department
using the eI_ListSummary widget to show a list of content. For
information about its properties, see eI_ListSummary Widget
on page 185. In this case, the type of content is News with the
newest entry at the top. You can choose to automatically scroll
the content.

Communicates important dates and events to members of the
Engineering department using the eI_UpcomingEvents widget
to show a list of scheduled calendar events. For information
about its properties, see eI_UpcomingEvents Widget on page
203.

Displays the activity of people and groups with whom you have
connected using the ei_ActivityStream widget. Administrators
can determine the types of information that appears, such as
blogs, comments, micro-messaging status, and so on. For
information about its properties, see eI_ActivityStream Widget
on page 171.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

9

Block

Function

Engineering Collateral
Displays a list of content using the ei_News widget. For
information about its properties, see eI_News Widget on page
191. The newest and highest rated content is at the top.

From the Engineering Blog

Displays the content of the blog entries that are stored in the
Engineering Blog folder of CMS400.NET.

Departments > Marketing
The default Ektron eIntranet Marketing department page contains information
and features that are related to Marketing, such as industry news, most
requested collateral, members of the Marketing organization, and activity in the
department. The following figure shows the default Marketing page.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter
the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the eIntranet
site. The breadcrumb in the figure indicates that it is the Marketing department home page. Breadcrumbs also are navigation links. You can click Home to go to the home page, or
other links on the breadcrumb trail to go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Marketing Group Members

Marketing News

Upcoming Marketing
Events

Activity Stream

12

Displays the members of the Marketing department. This
content block uses the eI_CommunityGroupMembers widget
to show members in a community group. Administrators can
add, remove, and invite others to the group. For information
about its properties, see eI_CommunityGroupMembers
Widget on page 178.

Displays news items that affect the Marketing department
using the eI_ListSummary widget to show a list of content. For
information about its properties, see eI_ListSummary Widget
on page 185. In this case, the type of content is News with the
newest entry at the top. You can choose to automatically scroll
the content.

Communicates important dates and events to members of the
Marketing department using the eI_UpcomingEvents widget
to show a list of scheduled calendar events. For information
about its properties, see eI_UpcomingEvents Widget on page
203.

Displays the activity of people and groups with whom you have
connected using the ei_ActivityStream widget. Administrators
can determine the types of information that appears, such as
blogs, comments, micro-messaging status, and so on. For
information about its properties, see eI_ActivityStream Widget
on page 171.
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Block

Function

Collateral Rack
Displays a list of content using the ei_News widget. For
information about its properties, see eI_News Widget on page
191. The newest and highest rated content is at the top.

From the Marketing Blog

Displays the content of the blog entries that are stored in the
Marketing Blog folder of CMS400.NET.

Departments > Human Resources
The default Ektron eIntranet Human Resources (HR) department page contains
information and features that are related to HR activity, such as common
forms, company announcements, job postings, and a schedule of events. The
following figure shows the default HR page.
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter
the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Human Resources department home page. Breadcrumbs
also are navigation links. You can click Home to go to the home
page, or other links on the breadcrumb trail to go to those
pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Members

HumanResources News

Displays the members of the HR department. This content
block uses the eI_CommunityGroupMembers widget to show
members in a community group. Administrators can add,
remove, and invite others to the group. For information about
its properties, see eI_CommunityGroupMembers Widget on
page 178.

Displays news items that affect the HR department using the
eI_ListSummary widget to show a list of content. For
information about its properties, see eI_ListSummary Widget
on page 185. In this case, the type of content is News with the
newest entry at the top. You can choose to automatically scroll
the content.

Upcoming
HumanResources Events
Communicates important dates and events to members of the
HR department using the eI_UpcomingEvents widget to show
a list of scheduled calendar events. For information about its
properties, see eI_UpcomingEvents Widget on page 203.

Activity Stream

Displays the activity of people and groups with whom you have
connected using the ei_ActivityStream widget. Administrators
can determine the types of information that appears, such as
blogs, comments, micro-messaging status, and so on. For
information about its properties, see eI_ActivityStream Widget
on page 171.
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Block

Function

HumanResources
Collateral
Displays a list of content using the ei_News widget. For
information about its properties, see eI_News Widget on page
191. The newest and highest rated content is at the top.

From the HumanResources
Blog
Displays the content of the blog entries that are stored in the
HumanResources Blog folder of CMS400.NET.

Departments > Sales
The default Ektron eIntranet Sales department page contains information and
features that are related to Sales interests, such as deals that are closed,
upcoming events, the salesperson of the month, members in the Sales
organization, and activity in the department. The following figure shows the
default Sales page.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet site.
You also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter the
Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Sales department home page. Breadcrumbs also are navigation
links. You can click Home to go to the home page, or other links
on the breadcrumb trail to go to those pages.

Quick link navigation block

This box of links connects you to important or often-used content.

Members

Displays the members of the Sales department. This content
block uses the eI_CommunityGroupMembers widget to show
members in a community group. Administrators can add,
remove, and invite others to the group. For information about its
properties, see eI_CommunityGroupMembers Widget on page
178.

Sales News
Display news items that affect the Sales department using the
eI_ListSummary widget to show a list of content. For information
about its properties, see eI_ListSummary Widget on page 185.
In this case, the type of content is News with the newest entry at
the top. You can choose to automatically scroll the content.

Upcoming Sales Events
Communicate important dates and events to members of the
Sales department using the eI_UpcomingEvents widget to show
a list of scheduled calendar events. For information about its
properties, see eI_UpcomingEvents Widget on page 203.

Activity Stream

Displays the activity of people and groups with whom you have
connected using the ei_ActivityStream widget. Administrators
can determine the types of information that appears, such as
blogs, comments, micro-messaging status, and so on. For information about its properties, see eI_ActivityStream Widget on
page 171.

Sales Collateral
Displays a list of content using the ei_News widget. For
information about its properties, see eI_News Widget on page
191. The newest and highest rated content is at the top.
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Block

Function

From the Sales Blog

Displays the content of the blog entries that are stored in the
Sales Blog folder of CMS400.NET.

Departments > Training
The default Ektron eIntranet Training department page contains information
and features that are related to training, such as class schedule
announcements, members of the training staff, links to videos, and news in the
department. The following figure shows the default Training page.

The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter
the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Training department home page. Breadcrumbs also are navigation links. You can click Home to go to the home page, or
other links on the breadcrumb trail to go to those pages.

Quick link navigation block

Connects you to important or often-used content.

Members

Training News

Displays the members of the Training department. This content
block uses the eI_CommunityGroupMembers widget to show
members in a community group. Administrators can add,
remove, and invite others to the group. For information about
its properties, see eI_CommunityGroupMembers Widget on
page 178.

Displays news items that affect the Training department using
the eI_ListSummary widget to show a list of content. For
information about its properties, see eI_ListSummary Widget
on page 185. In this case, the type of content is News with the
newest entry at the top. You can choose to automatically scroll
the content.

Upcoming Training Events
Communicates important dates and events to members of the
Training department using the eI_UpcomingEvents widget to
show a list of scheduled calendar events. For information about
its properties, see eI_UpcomingEvents Widget on page 203.

Activity Stream

20

Displays the activity of people and groups with whom you have
connected using the ei_ActivityStream widget. Administrators
can determine the types of information that appears, such as
blogs, comments, micro-messaging status, and so on. For information about its properties, see eI_ActivityStream Widget on
page 171.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Block

Function

Training Collateral
Displays a list of content using the ei_News widget. For
information about its properties, see eI_News Widget on page
191. The newest and highest rated content is at the top.

From the Training Blog

Displays the content of the blog entries that are stored in the
Training Blog folder of CMS400.NET.
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Touring the Default Employee
Resources Pages
The Ektron eIntranet comes with the following default Employee Resources
pages.
Employee Resources > Welcome Guide below
Employee Resources > Book a Conference Room on page 25
Employee Resources > Request IT Help on page 26
Employee Resources > Forums on page 29
Employee Resources > Employee Handbook on page 31
Employee Resources > Newsletters on page 33
Employee Resources > Office Locations on page 35
Employee Resources > Building Maps on page 37
Employee Resources > Site Map on page 38
Creating a New Employee Resource Page on page 100

Employee Resources > Welcome Guide
The default Welcome Guide page (shown in the following figure) in the
Employee Resources area displays information you want new employees and
visitors to see. People can rate the content with the star ratings, add the page to
their Favorites, email a link of the page to a colleague, or send the page to a
printer.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department page, view the site map, go to the Welcome Guide page,
and enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Welcome Guide page in the Employee Resources area.
Breadcrumbs also are navigation links. You can click Home to
go to the home page, or other links on the breadcrumb trail to
go to those pages.
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Block

Function

Quick link navigation block

This box of links connects you to important or often-used
content.

Welcome Guide

You can edit this form by clicking on the silver access point ( )
and choose Edit.

To modify the Welcome Guide text, click on the silver access point ( ) and
choose Edit. The following figure shows the Workarea Editor that appears with
the content in it. You can change the title (for example, to "Getting Started,"
which also changes the menu item in Employee Resources), and the text on the
page. Click Publish ( ) to activate your changes.
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Employee Resources > Book a Conference
Room
The default Conference Room Calendar page (shown in the following figure) in
the Employee Resources area is where you display the schedule of conference
room bookings. To add a booking, double click on a day in the calendar and
enter the data in the editor that appears. Hover over an existing booking to pop
up details about the booking. For information about calendars, see the following
additional information.
Setting Up a Company Calendar on page 106
Changing the Calendars that Appear on a WebCalendar Widget on
page 112
Adding Calendar Events on page 108
Placing a WebCalendar Widget on a Page on page 107

The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter
the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Conference Room page in the Employee Resources area.
Breadcrumbs also are navigation links. You can click Home to
go to the home page, or other links on the breadcrumb trail to
go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Conference Room Calendar

The text "Conference Room Calendar" displays using the eI_
Header widget. You can name it anything you want. For information about its properties, see eI_Header Widget on page
184.

Calendar

Placing the WebCalendar widget on a page gives you
automatic calendar functions for you to schedule events.

Employee Resources > Request IT Help
The default Request IT Help page (shown in the following figure) in the
Employee Resources area is where you submit request for IT support. You can
set up email or activity stream notification for one or more of the IT staff, when
you click Submit Request.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter
the Workarea of the CMS400.NET.
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Block

Function

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Request IT Help page in the Employee Resources area.
Breadcrumbs also are navigation links. You can click Home to
go to the home page, or other links on the breadcrumb trail to
go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Request IT Help

You can edit this form by clicking on the silver access point ( )
and choose Edit.

To modify the Request IT Help form, click on the silver access point ( ) and
choose Edit. The following figure shows the Workarea Editor that appears with
the form content in it.
You can change the title (to "IT Help Request Form" as in the following figure,
which also changes the menu item in Employee Resources), the text on the
page, and the names for the fields and buttons. If you want to make more
comprehensive changes to the form, see the Working with HTML Forms section
in the Ektron CMS400.NET Reference Manual for detailed information.
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For information about viewing IT requests that have been submitted, see
Viewing IT Requests on page 162.

Employee Resources > Forums
The default Forums page (shown in the following figure) in the Employee
Resources area is where your employees join in collaborative and social
networking. The site administrator can create new forums, and assign
permissions to a person to moderate a forum. Moderating gives the moderator
added controls to ensure the forum keeps on track with its charter. For more
information about community groups, see Creating Community Groups on page
119.
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Forums page in the Employee Resources area. Breadcrumbs
also are navigation links. You can click Home to go to the home
page, or other links on the breadcrumb trail to go to those
pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Forums

The text "Forums" displays using the eI_Header widget. You
can name it anything you want. For information about its properties, see eI_Header Widget on page 184.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Block

Function
Display forums with the following information.
Forum name and link to enter the forum.
A brief description of the forum purpose.
The number of topics in the forum.
The number of posts that were entered by forum
members.
The date of the most recent posting.

Forum Content block

The controls above the forum block let you do the following:
Get notified by email when posts are made to topics in which you are interested, based on settings
in your forum preferences.
Get notified by RSS feed (SMS) when posts are
made to topics in which you are interested,
based on settings in your forum preferences.
Click on Control Panel to ...
Click on Search to search one or more forums
for content you want to find.

Employee Resources > Employee
Handbook
The default Employee Handbook page (shown in the following figure) in the
Employee Resources area is where your employees can find information about
standards and policies for your organization. Replace it with your company's
handbook (using the instructions following the figure and table).
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You
also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter
the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Employee Handbook page in the Employee Resources area.
Breadcrumbs also are navigation links. You can click Home to
go to the home page, or other links on the breadcrumb trail to
go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Employee Handbook

The text "Employee Handbook" displays using the eI_Header
widget. You can name it anything you want. For information
about its properties, see eI_Header Widget on page 184.
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Block

Function
Display documents using the eI_ListSummary widget. For information about its properties, seeeI_ListSummary Widget on
page 185.
Displays the owner of the document (Application
Administrator, in the figure).
Lets you add the document to your favorites by
click the green plus sign.

Content block

Lets you email a link to the document to a colleague.
Lets you send the document to a printer.
Lets you add a comment about the document
that everyone with access to the document can
see. The figure shows an example comment.

To replace the existing employee handbook, follow these steps:
1. Login as administrator.
2. Click Workarea.
3. Click the Content tab.
4. Choose Folders > Content > Company > Forms > Employee
Handbook.
5. Click
New> DMS Document to add a file to the Employee Handbook folder. (You can also create HTML content from scratch.) A new
content screen appears.
6. Enter a title and click Browse to locate an existing employee handbook from your company.
7. Click the Category tab and select a category, for example, Departments > HumanResources > Collateral.
8. Click Publish (
folder.

). The file appears in the Employee Handbook

9. To delete the default Employee handbook, choose
Delete
> Content, check the box next to the file and click Delete ( ). The
file is removed from the folder.

Employee Resources > Newsletters
The default Newsletters page (shown in the following figure) in the Employee
Resources area is where you to link to newsletter files.
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Newsletters page in the Employee Resources area. Breadcrumbs also are navigation links. You can click Home to go to
the home page, or other links on the breadcrumb trail to go to
those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Newsletters

The text "Newsletters" displays using the eI_Header widget.
You can name it anything you want. For information about its
properties, see eI_Header Widget on page 184.

Collection block

Display newsletters and related information and make them
available to your employees. You can sort the content by
clicking on the column titles and you can give each item a star
rating. For information about its properties, see eI_Collection
Widget on page 176.
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For information about adding an asset, see Adding Assets to the Intranet on
page 97.

Employee Resources > Office Locations
The default Office Locations page (shown in the following figure) in the
Employee Resources area is where you define places of interest on a map such
as your office location and points of interest near your office.

The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Office Locations page in the Employee Resources area. Breadcrumbs also are navigation links. You can click Home to go to
the home page, or other links on the breadcrumb trail to go to
those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Office Locations

The text "Office Locations" displays using the Header widget.
You can name it anything you want. For information about its
properties, see eI_Header Widget on page 184.

Add Content

Click this button to add locations to the map. When you click
Add Content, a multi-tabbed dialog box appears.

To add a location to the map, do the following:
1. On the Content tab, enter the Title of the location. You also can add
an expanded explanation in the editing area.
2. On the Metadata tab, enter the address in the Map Address field. You
do not need to know the latitude or longitude (which are automatically
generated for you by the map function).
3. On the Category tab, select one or more categories to which your
address applies. For example, you may check USA and Headquarters.
4. Click the Publish button.
Note: If the new location does not show below the map, you may need to adjust the
zoom factor of the map. For example, if you entered a location in another state, zoom
the map out until you can see the new location and the current location on the same
map.

For information about the ei_Map widget, see eI_Map Widget on page 188.
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Employee Resources > Building Maps
The default Building Maps page (shown in the following figure) in the Employee
Resources area is where you to link to a floor map of your facilities. The map
must be in a file that you can upload (PDF, for example).

The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Intranet site. You also can log out of
page edit mode, add a department page, view the site map, go to the Welcome
Guide page, and enter the Workarea of the CMS400.NET.

Site Navigation
Menus
(upper left)

Use Site Navigation menus to go to Department pages, Employee Resources,
News and Events, and your personal space on My Intranet.

Breadcrumb
bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The
breadcrumb in the figure indicates that it is the Building Maps page in the
Employee Resources area. Breadcrumbs also are navigation links. You can click
Home to go to the home page, or other links on the breadcrumb trail to go to
those pages.

Search

Use the Search box to look for items on the Building Maps page.

Quick link
navigation
block

This box of links connects you to important or often-used content.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

37

Block

Function

Building
Maps

The text "Building Maps" displays using the eI_Header widget. You can name it
anything you want. For information about its properties, see eI_Header Widget
on page 184.

Collection
block

Display links to files containing information about your facilities and make them
available to your employees to help them find their way around. You can sort the
content by clicking on the column titles and you can give each item a star rating.
For information about its properties, seeeI_Collection Widget on page 176.

For information about adding an asset, see Adding Assets to the Intranet on
page 97.

Employee Resources > Site Map
The default Site Map page in the Employee Resources area is where an
automatically generated linked list of your eIntranet site hierarchy appears,
similar to the one shown in the following figure.

38

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

The following table describes each area of the page.
Block

Function

Site Navigation Tools

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department page, view the site map, go to the Welcome Guide page,
and enter the Workarea of the CMS400.NET.
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Block

Function

Site Navigation Menus

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Site Map page in the Employee Resources area. Breadcrumbs also are navigation links. You can click Home to go to
the home page, or other links on the breadcrumb trail to go to
those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Site Map

The text "Site Map" displays using the Header widget. You can
name it anything you want. For information about its properties, seeeI_ListSummary Widget on page 185eI_Header
Widget on page 184.

Site Map Linked List

Placing the Site Map widget on a page automatically
generates a linked list of pages from your site. For information
about its properties, see eI_SiteMap Widget on page 201.
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Touring the Default News & Events
Pages
The Ektron eIntranet comes with the following default News and Events pages.
News & Events > Company News below
News & Events > Messages from Management on page 43
News & Events > Announcements on page 44
News & Events > CEO's Blog on page 46
News & Events > Company Calendar on page 48
News & Events > Photo Gallery on page 50

News & Events > Company News
The default Company News page (shown in the following figure) in the News
& Events area is where you to link to news files.
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Company News page in the News and Events area. Breadcrumbs also are navigation links. You can click Home to go to
the home page, or other links on the breadcrumb trail to go to
those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

News collection block

Display news and related information and make them available
to your employees. You can sort the content by clicking on the
column titles and you can give each item a star rating. For
information about its properties, see eI_Collection Widget on
page 176.

For information about adding an asset, see Adding Assets to the Intranet on
page 97.

News & Events > Messages from
Management
The default Messages from Management page (shown in the following figure) in
the News & Events area is where you to link to information that management
wants to communicate with everyone.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, launch the Department Wizard, view the site map, go to the Welcome Guide
page, and enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Messages from Management page in the News and Events
area. Breadcrumbs also are navigation links. You can click
Home to go to the home page, or other links on the breadcrumb trail to go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Messages from Management collection block

Display messages and management-related information and
make them available to your employees. You can sort the
content by clicking on the column titles and you can give each
item a star rating. For information about its properties, see eI_
Collection Widget on page 176.

For information about adding an asset, see Adding Assets to the Intranet on
page 97.

News & Events > Announcements
The default Announcements page (shown in the following figure) in the News
& Events area is where you to link to information that you want to communicate
with everyone.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department page, view the site map, go to the Welcome Guide page,
and enter the Workarea of the CMS400.NET.
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Block

Function

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Announcements page in the News and Events area. Breadcrumbs also are navigation links. You can click Home to go to
the home page, or other links on the breadcrumb trail to go to
those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Announcements collection
block

Display messages and related information and make them
available to your employees. You can sort the content by
clicking on the column titles and you can give each item a star
rating. For information about its properties, see eI_Collection
Widget on page 176.

For information about adding an asset, see Adding Assets to the Intranet on
page 97.

News & Events > CEO's Blog
The default CEO's Blog page (shown in the following figure) in the News
& Events area is where your CEO communicates with the employees. For
information about modifying this page, see Adding Entries to the CEO's Blog on
page 78.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department page, view the site map, go to the Welcome Guide page,
and enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
CEO's Blog page in the News and Events area. Breadcrumbs
also are navigation links. You can click Home to go to the
home page, or other links on the breadcrumb trail to go to
those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.
You can do the following on the page:
Add a post. Clicking Add Post opens a Workarea
content editor.
Edit an existing post. Clicking Edit opens a Workarea content editor.
Delete a post.

CEO Blog

Create a permanent link to a specific blog post
that you can access it via the URL in the browser’s address bar. (Most blog pages show only
recent posts. After a post is moved off the blog’s
front page, it is still accessible via this link.)
Subscribe to receive a new blog post in an RSS
feed or sent by email.
View the current calendar month (dates with
blog entries are highlighted), and other blogrelated information .

News & Events > Company Calendar
The default Company Calendar page (shown in the following figure) in the News
& Events area is where you display the schedule of events for the company. To
add an event, double click on a day in the calendar and enter the data in the
editor that appears. Hover over an existing booking to pop up details about the
booking. For more information about calendars, see Setting Up a Company
Calendar on page 106.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department page, view the site map, go to the Welcome Guide page,
and enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Company Calendar page in the News and Events area. Breadcrumbs also are navigation links. You can click Home to go to
the home page, or other links on the breadcrumb trail to go to
those pages.
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Block

Function

Quick link navigation block

This box of links connects you to important or often-used
content.

Calendar

Placing the WebCalendar widget on a page gives you
automatic calendar functions for you to schedule events.

News & Events > Photo Gallery
The default Photo Gallery page (shown in the following figure) in the News
& Events area is where you collect and display images.

The following table describes each area of the page.

50

Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet site.
You also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter the
Workarea of the CMS400.NET.
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Block

Function

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Photo Gallery page in the News and Events area. Breadcrumbs
also are navigation links. You can click Home to go to the home
page, or other links on the breadcrumb trail to go to those pages.

Quick link navigation block

This box of links connects you to important or often-used content.

Photo Gallery

The Photo Gallery uses a breadcrumb bar to navigate through
subcategories of photo albums. Click top to return to the main
Photo gallery.
You can have photos organized in separate folders. Click on the

subcategories

green plus sign (
lery.

) to add a category of photographs to the gal-

You can perform the following functions:
Copy photos that you select by checking the box on
the photo. Then go to another folder and paste
them into the other folder by clicking on the clipManage Photos

board-with-content icon (
).
Delete photos that you select by checking the box
on the photo and then clicking the Delete button.
View the photos in the current folder by clicking on
the Launch Photo Viewer icon; the photo album
viewer appears. Check Slide show to automatically
cycle through the pictures in the album.
To add a photo, do the following:
1. Click Add Photos.

Add Photos

2. Depending on your browser, you can upload photos one at a time or more than one file at a time. For
information about your browser's method, see Adding Assets to the Intranet on page 97. Your selections are added to the top of the collection list.
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Touring My Intranet Pages
The Ektron eIntranet comes with the following default My Intranet pages.
My Intranet > My Profile below
My Intranet > Activity Timeline on page 55
My Intranet > Directory on page 57
My Intranet > Search on page 59
My Intranet > Tag Cloud on page 60

My Intranet > My Profile
The My Profile page (shown in the following figure) in the My Intranet area is
where you can enter information about you that lets you connect and
collaborate with other people in your organization. For information about
setting up your profile, see Editing My Profile on page 137.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet site.
You also can log out of page edit mode, add a department page,
view the site map, go to the Welcome Guide page, and enter the
Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.
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Block

Function

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is your
profile page. Breadcrumbs also are navigation links. You can click
Home to go to the home page, or other links on the breadcrumb
trail to go to those pages.

Edit Profile

Your profile is where you set information about you as a member
of the Ektron eIntranetcommunity. A tabbed dialog box lets you
define data such as name, contact information, location,
categories to which you belong (for example, Marketing, and
Press Release),and the activities that you want to follow in your
Activity Stream, or by email or SMS. For information about setting
up your profile, see Editing My Profile on page 137.

Calendar

The calendar in My Profile is your own personal calendar.

Groups

The Groups page in My Profile lets you make requests to join a
group. If you are a group moderator or an Administrator, you also
can create new groups and perform other functions that other
people cannot, such as deleting a post. Note: When you click on
a group, your breadcrumb bar indicates that you enter the
Groups area and are no longer in the Users area.

Colleagues

Colleagues are people with whom you establish a friendly or professional connection. This is often a subset of the entire eIntranet
community; people that you interact with on a professional basis.
To connect to a colleague, search for the colleague in the directory, and click on Add as Colleague. This sends a request to the
person to approve or ignore the connection request. If approved
you can follow your colleague's status updates and activities (if
profile settings allow).

Blog

Create a blog that colleagues can read.

Dashboard

Create your own personal landing page, also called a Dashboard. You can choose from among many widgets to customize
your page.

Documents

Upload documents that you want to share with everyone, just
your colleagues, selected colleagues, or keep them private.

Favorites

Keep track of your favorite web pages. Enter (or cut and paste) a
URL, enter a title, and click Add to create another favorite item.

Photos

Create photo albums and upload your photos, which you can
share with everyone, just your colleagues, selected colleagues,
or keep them private.
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Block

Function
You can enter your own status (referred to as micro-messaging)
and follow the statuses of others.
You can view statuses as follows using the status tabs:
Public Messages - Displays messages from
every eIntranet member.

Status Pane

Private Messages - Displays messages only
between you and another colleague.
Colleagues Activity - Displays the activities of the
colleagues that you set to follow.
My Activity - Displays your past activity statuses.
Contact Information - Displays your contact information. To modify this, click on Edit Profile.

Messages from others community users arrive in your message
box instantaneously when the author composes and sends it in
their own My Messages page. The home page shows you when
you have messages by a link located next to the My Profile links at
the top.

My Messages

Click this link to see the My Messages page in your personal
profile area. You can read and respond to the message or
compose a new one. Additionally you can review messages you
have sent or delete messages.

My Intranet > Activity Timeline
The Activity Timeline page (shown in the following figure) in the My Intranet
area is where enter your current status so that anyone who is following you on
an activity stream will see what you wrote.
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The following table describes each area of the page.
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Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.
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Block

Function

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Activity Timeline page in the My Intranet area. Breadcrumbs
also are navigation links. You can click Home to go to the home
page, or other links on the breadcrumb trail to go to those
pages.

Quick link navigation block

This box of links connects you to important or often-used
content.
You can do the following on the page:
Enter your status and click Update Status.
View the 10 most recent status updates.

Activity Timeline

Reply to a status.
Delete a status .
Open the Activity Timeline Search tab and
search all statuses for a text string.

For more information about activity streams, see Customizing the Activity
Stream on page 70.

My Intranet > Directory
The Directory page in the My Intranet area is where you find people and groups
on your eIntranet. The following figure shows the default group directory.
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The following table shows each area of the page.

58

Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Directory page in the My Intranet area. Breadcrumbs also are
navigation links. You can click Home to go to the home page,
or other links on the breadcrumb trail to go to those pages.
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Block

Function

Quick link navigation block

This box of links connects you to important or often-used
content.
You can do the following on the page:

Directory

Search for people on the Colleague Directory
tab. You also can filter the list by category. For
example, you can show only the people in the
Marketing department, or people who write
blogs.
Search for groups on the Group Directory tab.
You can also sort the list by newest, most popular, group name, and group invitations. You can
create a new group
You can modify the display of the groups in the following ways:
Create a new group.
Sort the list of groups by the most recently
created to the earliest created group.

Group Links

Sort the list of groups by placing the most active
at the top.
Sort the list alphabetically.
Display groups in which you are e member.
Display the groups to which you have applied for
membership.
Display the groups to which you are invited to
join.

My Intranet > Search
The Search page (shown in the following figure) in the My Intranet area is
where enter can look for data on your eIntranet site. For more information
about search, see eI_WebSearch Widget on page 205.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department
page, view the site map, go to the Welcome Guide page, and
enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Search page in the My Intranet area. Breadcrumbs also are
navigation links. You can click Home to go to the home page,
or other links on the breadcrumb trail to go to those pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Search

You can search by site, colleagues, groups, or activity. The
Basic Search is the same as the Search in the upper right
corner of your page. The Advanced Search provides even
more ways to filter your search criteria.

My Intranet > Tag Cloud
The Tag Cloud page (shown in the following figure) in the My Intranet area is
where you can view the most active areas of your Ektron eIntranet site. The
size of each tag is proportional to the number of times it is assigned.
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The following table describes each area of the page.
Block

Function

Site Navigation Tools
(upper right)

Use the Site Navigation tools to search the Ektron eIntranet
site. You also can log out of page edit mode, add a department page, view the site map, go to the Welcome Guide page,
and enter the Workarea of the CMS400.NET.

Site Navigation Menus
(upper left)

Use Site Navigation menus to go to Department pages,
Employee Resources, News and Events, and your personal
space on My Intranet.

Breadcrumb bar

Breadcrumbs help you see where you are on the Ektron eIntranet site. The breadcrumb in the figure indicates that it is the
Tag Cloud page in the My Intranet area. Breadcrumbs also
are navigation links. You can click Home to go to the home
page, or other links on the breadcrumb trail to go to those
pages.

Quick link navigation block

This box of links connects you to important or often-used
content.

Tag Cloud

Displays tags in proportion to how many times they are used
on the Ektron eIntranet site.

For more information about Tag Cloud server control, see the Ektron
CMS400.NET Reference Manual.
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Chapter 2

Modifying the eIntranet
You can customize the Ektron eIntranet to suit your organization. The following
topics are explained in this chapter:
Editing the Default Home Page on next page
Modifying Department Pages on page 90
Creating Content in the eIntranet on page 94
Creating Community Groups on page 119
Editing My Profile on page 137
Setting Up Permissions for the eIntranet on page 152
Using the SmartDesktop to Manage Your eIntranet on page 164
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Editing the Default Home Page
Login as administrator to edit the default Ektron eIntranet home page.
1. Click Login at the upper right of the page.
2. Enter the administrator username and password. The PageBuilder
menu appears (collapsed) at the upper left side of the page (as shown
the following figure).
3. Click the right/left arrow button to open the PageBuilder menu.

4. Choose File > Edit to begin editing the default home page.
Click on PageBuilder Video to see a video about What Do You Want Your Website
to Do?
This section describes the following tasks:
Changing the Logo Image below
Displaying Upcoming Events on the facing page
Changing the Photo of the Day on page 67
Customizing the Activity Stream on page 70
Adding Links to the Quick Reference Collection Widget on page 74
Changing the Contents of the Phone Book on page 75
Adding Entries to the CEO's Blog on page 78
Creating and Displaying Announcements on page 80
Displaying News Items on page 83
Modifying the Twitter Feed on page 86

Changing the Logo Image
The Ektron eIntranet logo appears in the top left corner of the every page of the
Ektron eIntranet site.
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To replace this logo with one that represents your organization, follow these
steps.
1. Obtain the new image in the .png image format. The logo file
installed with the Ektron eIntranet is 273 x 61 pixels.
2. Name the new image logo.png.
3. On the server to which you installed Ektron eIntranet, open Windows
Explorer.
4. Navigate to the images folder in the path where you installed the
Ektron eIntranet: c:\inetpub\wwwroot\eIntranet\images, by
default.
Note: If you want to keep a copy of the original logo, rename it old_logo.png.

5. Paste the new image to the images folder.

Displaying Upcoming Events
The Upcoming Events widget displays events that have been scheduled on a
calendar. To add an event to what is displayed in the Upcoming Events widget,
add an event to the Company Calendar by choosing News & Events
> Company Calendar.
You can also change the display by selecting a different calendar, as shown in
the following steps:
1. With the page open for editing, click on the edit icon (
Widget dialog box appears.

). The Editing
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2. Click on the Folder tab.
3. Scroll down to see that eIntranetCalendar is highlighted. In the
CMS400.NET, the eIntranetCalendar is in Folder ID 163.
4. To change the events displaying in the Upcoming Events widget,
choose another calendar - ConferenceRoom Calendar for example
- then click Save. The Upcoming Events Widget shows the scheduled
conference room bookings.
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Note: You also should change the header if you are changing the calendar events in the
Upcoming Events widget. See eI_UpcomingEvents Widget on page 203 for information about
Upcoming Events widget properties.

For information about setting the properties of the widget, see eI_
UpcomingEvents Widget on page 203.

Changing the Photo of the Day
The Photo of the Day widget displays a single photo, as shown in the following
figure.

The following sections show you how to replace the photo.

Replacing the Photo with One from the Ektron
eIntranet
When you installed the Ektron eIntranet, several photos were installed. To
replace the current photo with one of them, follow these steps.
1. On the home page, login as administrator.Navigate to the home page.
A Photo of the Day widget appears in the top center of the home page.
2. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
3. On the Photo of the Day widget, click the Edit button ( ). The edit
screen appears, and the Photo Gallery folder is selected (you must
scroll down to see it).
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Note: You can hover over photos in the View Results area to preview the images.

4. Click the photo of your choice.
5. Click Save and the selected image is now the Photo of the Day.
For information about adding photos to the Photo Gallery, see Adding Photos to
the Gallery on page 101.

Replacing the Photo with One from Your Computer
To replace the Photo of the Day with one from your computer or network, follow
these steps.
1. On the home page, login as administrator.
2. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
3. On the Photo of the Day widget, click the Edit button (
screen appears.
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). The edit

4. Click the Upload tab.

5. Click the Select Files button.
6.

Navigate to and select an image file.
Note: The image file type must be .gif, .jpg, .jpeg, .png, or .wmf. In the Ektron
CMS400.Net Workarea, your site administrator determines the image file types that
people can import.

7. The file name appears on the screen. Click the Upload button.
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8. When the file's status changes to Complete, scroll among the files in
the lower section of the screen (under View Results) and select the
file you just uploaded.
9. Click the Save button.
The selected image is now the Photo of the Day.
For information about other Photo of the Day features (for example, changing
the header text), see eI_PhotoOfTheDay Widget on page 194.

Customizing the Activity Stream
The Activity Stream widget shows a series of chronologically-arranged
activities for any user or community group. The most recent activities appear
on top.
By default, the Activity Stream widget on the home page shows activities
submitted by yourself, your colleagues, and your community groups.
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Additional Activity Stream widgets appear on other Ektron eIntranet pages,
such as Departments > Engineering > Activity Stream, where that
version of the widget displays group activities, such as when a new member is
added to the group, or new content is posted to the group page.
You can customize an Activity Stream widget so that it displays the activities of
any user or Community Group.

Displaying User Activity in the Activity
Stream
To change the user whose activities appear in the Activity Stream widget, follow these steps.
Note: After you change the user, you only see that user's activities, not those of his colleagues or
groups.

1. From the home page, log in as administrator.
2. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
3. Click the orange arrow in the upper right corner to close the PageBuilder menu.
4. Click Workarea to find the ID of the user you want to follow in the
Activity Stream.
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5. Click Settings > Users.
6. Click the username of the person whose activity stream you want to
display.
7. Note the ID number as shown in the following figure.

8. Return to Ektron eIntranet.
9. Navigate to the page with the Activity Stream widget.
10. Click the Edit button (

) on the widget.

11. In the Object ID field, enter the user ID you obtained in Step 7.
12. In the Feed Type field, select User.
13. Click Save.

Displaying Group Activity in an Activity
Stream
To display the activity of a group in the Activity Stream widget, follow these
steps.
1. From the home page, log in as administrator.
2. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64.
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3. Click the orange arrow in the upper right corner to close the PageBuilder menu.
4. Click Workarea to find the ID of the group you want to follow in your
Activity Stream.
Show me.

5. Click Settings > Community Management > Community
Groups.
6. Get that user group's ID number (circled below).

7. Return to Ektron eIntranet.
8. Navigate to the page with the Activity Stream widget.
9. Click the Edit button (

) on the widget.

10. In the Object ID field, enter the Community Group ID you obtained
in Step 6.
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11. In the Feed Type field, select Community Group.
12. Click Save.
For information about the properties of the widget, see eI_ActivityStream
Widget on page 171

Adding Links to the Quick Reference
Collection Widget
A collection is a list of content links. To add a link to the Quick Reference
collection widget, do the following:
1. Click the access point ( ) and choose Add Items. The Add Items to
Collection "Reference" dialog box appears showing folders in the
CMS400.NET. (To see the collection in the CMS400.NET, choose Properties from the access point menu ( ).)
2. Double click on folders to navigate to the content you want to display
in the Quick Reference collection widget. For example, choose Content > Company > Forms, and check the box next to Company
Phone Book.

74

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

3. Click Add ( ). The Company Phone Book (in this example) appears
at the end of the list.

For information about the collection widget properties, see eI_Collection
Widget on page 176.
For more information about creating and modifying collections in CMS400.NET,
see the Ektron CMS400.NET Reference Manual.

Changing the Contents of the Phone Book
The Phone Book on the home page is displayed in a Content Block widget, which
displays whatever CMS400.NET content item you choose to put in it. However,
instead of editing directly in the widget, you select existing content from the
CMS400.NET to display inside the Content Block widget.
To choose a content item, follow these steps:
1. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
2. Click Edit ( ) in the Phone Book content block widget. The Editing
Widget dialog box appears.
The following figure shows that the Company Phone Book content
is located in the following CMS400.NET folder on the Folders tab at
Root > Company > Forms.
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3. Select a different content item from any folder. For example, choose
Root > Company > Announcements, and click on Q4 Results in
the View Results field to change the content that appears in the
widget. (You also should change the Header Text and check Show
Content Title and other properties on the Properties tab before
clicking Save.)
To modify the listing of phone numbers that are displayed on the home page, follow these steps:
Note: You must modify that content item in the Workarea of the CMS400.NET. You can find the
Phone Book content at Content > Folders > Content > Company > Forms.

1. Click on Workarea.
2. Open the drop down menu beside the Company Phone Book item
and choose Edit.
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3. Modify an existing Department name and Extension, or click on Phone
Number to add a new one to the list.

4. Click Publish (

) to display the changes on the home page.

For information about the content block widget, see eI_ContentBlock Widget on
page 180. For information about editing content in the Workarea of the
CMS400.NET, see the Ektron CMS400.NET Reference Manual.
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Adding Entries to the CEO's Blog
The CEO's Blog on the home page displays the latest entry of a web log (blog),
showing the title of the blog entry and the first few lines of the blog, and Read
More link. When you click Read More, the CEO Blog page appears with the
latest and previous blog posts.
You can change the content of this eI_RecentBlogPosts widget in the following
ways:
Creating a new blog entry in a CMS400.NET editor from the access
point.
1. Login as administrator.
2. Click the access point ( ) and choose Add New Post. The
CMS400.NET editor appears.
3. Add the content that you want, including Title and other
variables, such as Metadata and Category information.
4. Click Publish ( ) when you want the content to appear
on the CEO's Blog display on the home page. For more
information about editing content in the CMS400.NET, see
the Ektron CMS400.NET Reference Manual.
Adding a blog entry to the CEO Blog folder from the CMS400.NET
Workarea.
1. Login as administrator.
2. Click Workarea.
3. On the Content tab, navigate to Folders > Content
> Company and then click on CEO Blog.
The following figure shows the folder path to the CEO Blog
folder.
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4. Choose New > HTML Post to create new blog entry in
an editor.
The following figure shows the editor with an example
blog entry.

When the example is published, it looks like this on the
home page:
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Choosing another blog folder from the CMS400.NET to display in the
widget.
1. Edit the page using PageBuilder, as explained in Editing
the Default Home Page on page 64
2. Click the Edit button (

) on the widget.

3. Click the Folder tab.
4. Choose another blog folder and click Save. The contents
of the selected folder are displayed. For example, choose
Content > Departments > Engineering
> Engineering Blog and see the results.
For information about the eI_RecentBlogPosts widget, see eI_RecentBlogPosts
Widget on page 197.

Creating and Displaying Announcements
Announcements on the home page are displayed from a list of items in a folder
in the CMS400.NET. You can change the content of this List Summary widget in
the following ways:
Edit the content of the Announcements folder from the CMS400.NET
Workarea.
1. Click Workarea.
2. On the Content tab, navigate to Folders > Content
> Company > Forums and then click on Announcements.
The following figure shows the folder path.
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3. Click New Topic ( ). A Post New Topic editor appears.
The following figure shows an example of creating an
announcement.
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4. Click Save ( ) to add the announcement to the folder.
The Announcements block on default home page will look
like this:

Choose another folder of content from the CMS400.NET to display in
the widget.
1. Click the Edit button (
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) on the widget.

2. Click the Folder tab.
3. Choose another folder and click Save. The contents of the
selected folder are displayed. For example, choose Root
> Content > Company > Announcements and see
the results.
Important: There are 2 Announcements folders in
the default eIntranet CMS400.NET. The Forums>
Announcements folder displays only items with a
content type of Discussion Topic by default. If you
change the folder to Company > Announcements
the items will not display on the home page
because the items in that folder are a different
content type. To display the contents of the
Company > Announcements folder, click the
Properties tab, and choose AllTypes on the
Content Type drop down menu.

For information about the ListSummary widget, see eI_ListSummary Widget on
page 185.

Displaying News Items
The News Items on the home page displays a list of content items in a
CMS400.NET folder. You can change the content of this List Summary widget in
the following ways:
Add new content to the list.
1. Login as administrator.
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2. Open the access point ( ) and choose Add Content. The
CMS400.NET editor appears.
3. Enter the title and the content that you want.
4. Click Publish ( ) when you want the content to appear
on the News Item display. For more information about
editing content in the CMS400.NET, see the Ektron
CMS400.NET Reference Manual.
Add a non-HTML document to the list.
When you upload a file that is not HTML content (for
example a Word document), you must change the
Content Type property to All Types. Then it appears
in the News Items display.
1. Edit the page using PageBuilder, as explained in Editing
the Default Home Page on page 64
2. Click Edit (

). The Editing Widget dialog box appears.

3. Change Content Type to All Types and click Save.
4. Choose New > DMS Document. (If you want to drag
and drop more than one document, choose New > Multiple DMS Documents.) An Upload dialog box appears.
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5. Enter a title. For example, 401k Retirement Planning.
6. Click Browse and locate the file that you want to upload.
For example, 401k Retirement Planning.doc.
7. Click on the Category tab and select one or more categories to which this item belongs. For example, you can
set this to Company-Wide News and HumanResources Collateral.
8. Click Publish (
folder.

) to upload the document into the News
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Choose another CMS400.NET folder to display in the eI_ListSummary
widget.
1. Edit the page using PageBuilder, as explained in Editing
the Default Home Page on page 64
2. Click Edit (

) on the widget.

3. Click the Folder tab.
4. Choose another folder and click Save. The contents of the
selected folder are displayed in the widget. For example,
choose Root > Content > Company > Management
Messages and see the results.
For information about the eI_ListSummary widget, see eI_ListSummary Widget
on page 185.

Modifying the Twitter Feed
By default, the Twitter™ Feed widget on the Ektron eIntranet home page
displays tweets from the Ektron's Twitter RSS
feed (http://twitter.com/statuses/user_timeline/96145394.rss).
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To set the widget to follow a different Twitter account, follow these steps.
1. Open the Twitter account page that you want to follow. For example,
http://twitter.com/bill_Ektron.
2. In the lower right side of the screen, click the RSS feed.
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3. In the browser address bar, copy the URL.

4. Open the Ektron eIntranet home page.
5. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
6. Click the Edit button (

) on the Twitter Feed widget.

7. If there is an existing feed that you do not want, delete it.

8. In the Name field, enter the Twitter account name.
9. In the Url field, paste the address you copied in Step 3.
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10. Press the <Home> key to move the cursor to the beginning of the Url
field.
11. Click Add.
12. Click Save.
The Ektron eIntranet home page refreshes, and the new feed appears in the
Twitter widget.

Removing the Help Widget
Getting Started with Ektron eIntranet online help was placed on the home page
for administrators to introduce Ektron eIntranet and to help you set up your
Ektron eIntranet site. Your intranet users will not need this information
accessible from the home page.
To remove the Help widget from the default home page, follow these steps.
1. Login as administrator.
2. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
3. On the Help widget, click Remove ( ).
You can access the online help from the Workarea at the root content folder. To
re-add it, create a Content widget and assign this ID to it.
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Modifying Department Pages
You can modify the department pages that come with Ektron eIntranet, or you
can create new ones. You can also delete a department from the eIntranet.
These actions are described in the following sections:
Modifying an Existing Department Page below
Creating a New Department Landing Page below
Deleting a Department from the eIntranet Site on page 92

Modifying an Existing Department Page
You modify a department page with PageBuilder in the same way that you
would modify the home page, as described in Editing the Default Home Page on
page 64.
Department Pages have the following default widgets:
Widget Area

Widget Used

See Also

Members

eI_CommunityGroupMembers Widget on
page 178

Creating Community Groups on
page 119

News

eI_ListSummary Widget on page 185

Displaying News Items on page 83

Upcoming Events

eI_UpcomingEvents Widget on page 203

Displaying Upcoming Events on
page 65

Activity Stream

eI_ActivityStream Widget on page 171

Customizing the Activity Stream on
page 70

Collateral

eI_News Widget on page 191

Adding Assets to the Intranet on
page 97

Blog

eI_RecentBlogPosts Widget on page 197

Adding Entries to the CEO's Blog on
page 78

To create a new page under the department landing page, see Adding a New
Page on page 94.

Creating a New Department Landing Page
To create a new department landing page, follow these steps:
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1. Click on Department Wizard at the top right of the home page. The
following wizard dialog box appears.

2. Enter the name of the new department in the dialog box.
3. Click Add. The new department (Quality Assurance in this example) is
added to the Departments navigation menu.

When you create the department, its landing page appears (Quality Assurance
example shown in the following figure). The new department page is preloaded with Collateral, Activity Stream, Calendar, Groups Spaces, News, and a
new Blog, or choose your own content by editing the page. To modify this page,
see Modifying an Existing Department Page on previous page.
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Note: The members community block is a discussion group about things of interest to the
department. Anyone can join the discussion group. If you want only department staff members to
shows in the members list, see Creating a Restricted Group on page 121.

For information about setting department permissions, see Setting Up
Permissions for Department Pages on page 158.

Deleting a Department from the eIntranet
Site
To delete an existing department, including its menus, aliases, taxonomies,
folders, tags, and community groups, follow these steps:
1. Click on Department Wizard link in the upper right corner of the
page. The following wizard dialog box appears.
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2. Check the box next to the department that you want to delete from
the intranet site (Quality Assurance in the example) and then click
Delete Departments. A warning dialog box appears to confirm your
action to delete the department.
Note: You may need to refresh your browser (F5) for the Department menu to be
updated after the deletion operation is complete.
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Creating Content in the eIntranet
Populate your Ektron eIntranet with new pages and content that your colleagues
and employees want and need to be more productive and effective. You can do
the following:
Adding a New Page below
Adding Assets to the Intranet on page 97
Adding Photos to the Gallery on page 101
Setting Up a Company Calendar on page 106

Adding a New Page
PageBuilder lets you easily add a new page to your web site, choose the basic
layout style, and add the widgets you want. The following example shows how
to create a new page for the Human Resources department that contains
navigation and two content widgets.
1. Choose Departments > Human Resources.
2. Click the left/right arrow button to open the PageBuilder menu.

3. Choose File > New Page to start the Add New Page Wizard as shown
in the following figure.
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4. Choose from several wireframe styles, for example,
home1Zone.aspx. Your choice is highlighted with a checkmark in the
upper right corner.
5. Click Next to continue.
6. Enter the page title, taxonomy category, alias name, and extension as
shown in the following figure.

7. Click Next to continue.
8. Skip entering Metadata and Summary and click Finish.
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9. Click OK to begin editing the new page. The new page appears it
which you can place widgets shown by the yellow blocks.
10. Click the up/down arrows to show the widget bar (

).

11. Drag-and-drop widgets (for example, Photo Of The Day and ContentReview widgets) onto the yellow zones on the page as shown in
the following figure. (The following figure shows the ContentReview
Widget about to be placed on the page.)

12. Add a photo by clicking on Edit ( ) and choosing one from the Photo
Gallery. (For example, choose Office Location in Root > Content
> Company > Photo Gallery)
13. Choose File > Publish from the PageBuilder menu. The new page displays.
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Setting Navigation to Your New Page
A page is not connected to the eIntranet site until you set the navigation to the
page so others can find it. You can do this by any of the following:
Create a hyperlink in another content that links to this page.
Use the URL you established in the Alias setting - http://<yourhost>/conference/
Add this page into the appropriate menus on the top navigation
menus.
Search result lists automatically find this page when you enter proper search
terms.

Adding Assets to the Intranet
Assets are files that are created outside of CMS400.NET. You can store and
manage assets on your Ektron eIntranet site as shown in the following
examples.
To add a single asset, do the following:
1. Find a page that accepts assets; for example, the Company News
page of the HR department page.
2. Click Add Asset (

). A dialog box appears.

3. Click on the File Upload tab.
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4. Click Browse to locate the photo file.
5. Click Upload.
The following browsers use different methods for uploading assets.
Adding Assets with Microsoft Internet Explorer below
Adding Assets with Google Chrome below
Adding Assets with Mozilla FireFox on the facing page
Adding Assets with Microsoft Internet Explorer and Microsoft Office on
the facing page

Adding Assets with Microsoft Internet Explorer
You can upload one file at a time using the File Upload dialog box.
1. Click Browse.
2. Select the file you want, then click Upload.

Adding Assets with Google Chrome
You can upload one file at a time using the File Upload dialog box.
1. Click Choose File.
2. Select the file you want, then click Upload.
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Adding Assets with Mozilla FireFox
You can upload one file at a time using the File Upload dialog box. You can also
upload multiple files clicking on the Drag Drop tab and dragging files to the
Drag Drop tab.
Show me.

Adding Assets with Microsoft Internet Explorer and
Microsoft Office
You can upload one file at a time using the File Upload dialog box.
1. Click Browse.
2. Select the file you want, then click Upload.
You can also upload multiple files by checking boxes next to the files that you
want to upload.
1. Click the Multiple DMS Documents tab.
2. Check the boxes next to the files you want, then click Upload.

Note: You can see a list of allowed file types by clicking Show File Types. Ektron
CMS400.NET administrators can edit this list in the Workarea.

3. If any selected file type is not allowed, you are notified. Ektron eIntranet uploads all allowed file types.
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Creating a New Employee Resource Page
To add an Employee Resource page, follow these steps.
1. Click Resource Wizard in the top navigation area. A dialog box
appears.

2. Enter the name of a new employee resource and click Add. A new
Employee Resource page is created. The following figure shows a new
Employee Resource page that helps employees find Surplus Equipment.

When you create the new Employee Resources page, it's landing page
appears. The new page is pre-loaded with Content, a PageBuilder
Page, a taxonomy category and menu links.
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A link to this resource page is also added to the main menu under
Employee Resources > Resources.

Adding Photos to the Gallery
The Photo Gallery lets you manage images on your Ektron eIntranet site. The
default gallery has 3 images: earth.gif, training center.jpg, and office
location.jpg, located at the top folder of the image hierarchy.
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Organizing Photos with Subcategories
You can add photos to the top folder, but you probably want to organize the
photos by setting up subcategories of images. For example, you may have a
photo menagerie of animals. Under top, create a subcategory folder called
animals, and under it create mammals, reptiles, birds, fish, and
invertebrates.
To set up animal categories, follow these steps.
1. From the Ektron eIntranet home page, click News & Events
> Photo Gallery.
2. Click Add New Category ( ) and enter animals in the folder field,
as shown, and click Add Taxonomy Category ( )

3. Click on the animals folder to select it.
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4. Repeat step 1 for each, entering mammals, reptiles, birds, fish,
and invertebrates.
The following example shows the Photo Gallery with the limited
animal taxonomy.

Adding Photos to a Subcategory Folder
To add a photo to a subcategory folder, do the following:
1. From the Ektron eIntranet home page, click News & Events
> Photo Gallery.
2. Click on a subcategory folder. For example, click on mammals.
3. Click Add Photos (

). The Add Photos dialog box appears.
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4. Enter a description of the photo and click Next.
5. Click on the File Upload tab.
6. Click Browse to locate the photo file.
7. Click Upload.
For more information about adding assets and browser-specific methods for
uploading, see Adding Assets to the Intranet on page 97.
The following figure shows the outcome of adding one photo to the
previously empty mammals folder.
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To add more than one photo at a time to a subcategory folder, do the following:
1. Click on a subcategory folder. For example, click on birds.
2. Click Add Photos (

) . The Add Photos dialog box appears.

3. Enter a description of the photos and click Next.
4. Depending on your browser, you can upload more than one file at a
time. For information about your browser's method, see Adding
Assets to the Intranet on page 97.
The following figure shows the outcome of uploading 3 photos to
the previously empty birds folder.
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Setting Up a Company Calendar
A WebCalendar widget displays events from any number of calendars. For
example, the Engineering home page's calendar widget could display the
following:
company events, from the company calendar
group events, from the Engineering Community Group calendar
the group manager's personal calendar, so anyone can find the
manager's contact information when he is out of the office
The events on each calendar are color-coded, so it is easy to distinguish them.
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The Ektron eIntranet provides a sample calendar widget on the News
& Events > Company Calendar page. You can perform the following
calendar functions.
Changing the Calendars that Appear on a WebCalendar Widget on
page 112
Adding Calendar Events on next page
Placing a WebCalendar Widget on a Page below

Placing a WebCalendar Widget on a Page
Because the WebCalendar widget is wide, you should only drop it onto a
PageBuilder page that has one column, such as one of the following pages.
News & Events > Company Calendar
Employee Resources > Book a Conference Room
Departments > Engineering > Activity Stream
If you want to create a new page for a calendar, use the home1zone.aspx
template, which has one column. For more information, see Adding a New Page
on page 94.
After you determine which page to use, follow these steps.
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1. Drag and drop a WebCalendar widget onto the page.
2. Add one or more calendars to the widget as described in Changing the
Calendars that Appear on a WebCalendar Widget on page 112.
3. Add events to the calendars as described in Adding Calendar Events
below.

Adding Calendar Events
Before you can add a calendar event, you must log out of the
PageBuilder menu.

To add an event to a calendar, follow these steps.
1. Access the Edit Appointment screen.
a. Navigate to News & Events > Company Calendar.
b. Double click a date. The following example adds an event to the 27th
of the month.

c. The Edit Appointment screen appears.
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2. Enter the Event Title, Location, and Description
a. Enter a Title, for example, Training Day. This title shows on the calendar and in the pop-up.
b. Enter the Location. This appears in the pop-up.
c. Enter the Description. This appears in the pop-up.
When viewing the calendar, anyone can hover over an event to see
these fields in the popup (as shown in the following figure).

3. Add the start time or all day option
At the bottom of the Edit Appointment screen, the selected date appears as the
Start Time, and All Day is checked. So, by default, the event does not have
start or end time.
Note: All-day events appear differently than those with start and end times. For example, in a
weekly view, all-day events appear at the top, while those with start and end times appear in
their time slot, as shown in the following figure.
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To add a start and end date and time, follow these steps.
a. Uncheck the All Day option.

b. For start and end dates, click the calendar button (
start date.

) and set the

c. For start and end times, enter the time text or click the clock icon (
). If you use the clock button, choose the values and click Set when
finished.

4. Set recurrences.
You can set appointments to recur daily, weekly, monthly, or yearly, spacing
them at various intervals or having a finite duration or indefinite recurrence.
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To set a recurrence for a weekly event that occurs each Wednesday for the next
5 weeks, follow these steps.
a. Click the Recurrence tab on the Edit Appointment dialog box.
b. Check the Recurrence checkbox, as shown in the following figure.

c. Check the Weekly option.
d. Next to Recur every, enter 1 to have the events recur weekly.
e. Check the Wednesday checkbox.
f. Enter 5 to end after this many occurrences.
g. Click Save.
Note: If you edit a recurrence, you can edit either a single occurrence or the entire
series.

5. Save your appointment.
At any time, click Save.
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When you finish, the calendar looks similar to the following figure.

Changing the Calendars that Appear on a
WebCalendar Widget
Ektron eIntranet provides three WebCalendar types (listed below). All types can
appear in the WebCalendar widget.
System - shows events that affect your entire organization.
Community Group - shows a Community Group's events; appears
on a Community group's profile page.
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User - shows your personal events; appears on a user's profile page.

Note: Users can only create personal calendars if an administrator allows this in the
Workarea's Edit User screen > Custom Tab > Create User Calendar checkbox.

This section explains how to add or remove calendars from the WebCalendar
widget.

Accessing the Default WebCalendar Widget's Edit
Screen
To add or remove calendars from the WebCalendar widget on the Company Calendar page, follow these steps.
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1. From the home page, log in as administrator.
2. Edit the page using PageBuilder, as explained in Editing the Default
Home Page on page 64
3. Navigate to News & Events > Company Calendar.
4. Click the WebCalendar widget's Edit button (

).

5. The Editing Widget dialog appears. The default tab (Selected Calendars) shows all calendars currently assigned to this widget.

6. From this screen you can add and remove calendars. See Accessing
the Default WebCalendar Widget's Edit Screen on previous page
7. When you finish editing, go to the PageBuilder Edit menu and click
Publish.

Adding a System Calendar
To add a system calendar to the WebCalendar widget, follow these steps.
1. Click the Folder tab.
2. Navigate through the folder structure to find calendars to add to the
widget. Calendars are indicated by an icon and an Add button ( ).
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3. Click the Add button (

) next to the calendar you want to add.

4. The Selected Calendars tab reappears, showing the added calendar.
5. If you want to pick a background color for this calendar's events, click
the down arrow next to AutoSelect and click the color.
Note: AutoSelect chooses the next available color.

Adding a Community Group Calendar
To add a Community Group calendar, follow these steps.
1. Click the Group tab.
2. Enter one of the following pieces of information about the Community
Group. You must enter the term exactly.
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group name
a word in the group's description (small words are ignored, such
as the and for)
a tag assigned to the group
Note: If you do not have this information, you can find it by navigating to the Workarea >
Settings > Community Management > Community Groups screen.

3. Click Search Groups.
4. All Community Groups that fit the search criterion appear.

5. Find the group whose calendar you want to add.
6. Click

Add Calendar.

7. Click Save.

Adding a User Calendar
To add a user calendar, follow these steps.
1. Click the User tab.
2. To add your calendar to the widget, click Add My Calendar.
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To add another user's calendar, enter one of the following pieces of
information. You must enter the term exactly.
first name
last name
username
a tag assigned to the user
Note: If you do not have this information, you can find it by navigating to the
Workarea > Settings > Users screen, or to the Workarea > Settings > Community
Management > Tags > View All Tags screen.

3. Click Search Users.
4. All users that fit the search criterion appear.
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5. Find the user whose calendar you want to add.
6. Click

Add Calendar.

7. Click Save.
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Creating Community Groups
Community groups provide common interest areas for people to collaborate.
You can create groups, join groups, maintain documents, calendars, discussion
boards, blogs, and photos. A group moderator creates a group and determines
whether the group is restricted or public.

Viewing Community Groups
To see the list of available groups, follow these steps.
1. Choose My Intranet > Directory.
2. Select the Groups Directory tab.
3. Choose a group from the list. If the group is public (or a group in
which you are already a member), the Members & Activity page
opens with all the content visible.
If you are not a member of a restricted group, you may request to
join it by clicking this link. After your request is granted by the group
moderator, you see the Members & Activity page.
For more information about group spaces, see Touring Group Spaces on page
124.

Creating a Community Group
To create a Community Group, follow these steps.
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1. Go to My Intranet > My Profile.
2. Click the Groups tab.
3. Click the Create Group button.

Field

Description

Properties Tab
Group Name

The name of the group.
A group administrator has privileges to delete a group or edit its
properties.

Administrator

By default, the person who created the group is the group
administrator. Click the Browse button if you want to select a
different group administrator.
Select whether the group is
Open - open to the public

Membership

Restricted - members can only join if invited
For more information, see Adding Members to a Restricted Group
on page 131.
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Image

Upload an image to use as an avatar for the group.

Location

The geographical location associated with the group.

Short Description

A brief description of the group.

Description

A fully detailed description of the group.
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Field

Description
Check this box if you want the group and system administrator to be
able to distribute content to any folder.

Enable Distribute
For more information, see "Distributing Content to Another Folder"
in the Ektron CMS400.Net Reference Manual.

Allow member to
manage
photo/workspace folders

Check this box if you want to allow members to add, remove and
control the sharing of folders in a community group’s Photo Gallery or
Document’s Workspace. For more information, see Managing
Group Photos on page 135.

Group MessageBoard
Moderation

Check this box if you want to this groups message board to be moderated. For more information, see Moderating a Group Message
Board on page 130.

Group Tags

From this screen, you can either create a new tag or select from a
default list of community group tags. For more information, see
"Assigning Tags to a Community Group" in the Ektron CMS400.Net
Reference Manual.
The categories tab lists all of the categories associated with the
community group.

Category List

Note: This table appears only if you have defined at least one
taxonomy for community groups. or more information, see "Creating
a Taxonomy" in the Ektron CMS400.Net Reference Manual.

Creating a Restricted Group
Any person can request to join a restricted group, but the moderator of the
group must accept or reject the request. Members of a restricted group can
discuss matters among the group and non-members do not have access to
those discussions or documents within the group.
When a department page is created, an open community group is automatically
created and associated with the department, as shown in the following figure.
Anyone in the intranet can join that public group.
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For information about joining or inviting colleagues to a group, see Adding
Members to a Restricted Group on page 131.
If you want to use the eI_CommunityGroupMembers widget to display only the
staff members of your department, create a new, restricted group and invite
only the members of the department staff.
To create a restricted group, follow these steps:
1. On a department page in the block on the left side of the page, click
Group Spaces. The Group Spaces page appears.
2. On the right side, click Create Group. The Create Group dialog box
appears.
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3. Specify a Group Name, such as Quality Assurance Staff.
4. Click the Restricted radio button.
5. Optionally specify the other fields, select a category on the Category
tab, and click Save ( ). The new group appears in your group list.
To display the new group on your department page, follow these steps.
1. Edit the department page using PageBuilder, as explained in Editing
the Default Home Page on page 64
2. Open the widget menu (
) and drag and drop the eI_
CommunityGroupMembers widget onto the page.
3. Click Edit (

). The Editing dialog box appears.
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4. Specify the Group ID and change the Header. For example, the
header might be Quality Assurance Staff like the name of the group.
Note: To find the Group ID, open the Workarea and choose Settings > Community
Management > Tags > Community Groups. The group list displays in the main
panel. Note the ID number for the Editing Widget dialog box.

5. Click Save. The new group appears on the department page.

Touring Group Spaces
The following sections describe the groups spaces on the Ektron eIntranet.

Group Members & Activity
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Section

Description
Displays the status of colleagues when they
perform tasks within the group. These actions may
include adding content or documents, or posts to a
forum or blog.
Group members determine which type of activities
to share by editing their Profile's Activities tab.

Displays group members. Click a member's photo
or name to go to their profile page.

When colleagues visit your group page, they can
leave messages on the message board, such as a
status update or a question.
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You can access other pages associated with your group using the links on the
left side, shown in the following figure.

Group Dashboard
The Dashboard lets you customize a group page to include content for your
group, such as a list of content, a collection of links, documents, or images. To
customize your dashboard, drag-and-drop the widget you want into the location
on the page you choose, as shown below.

Group Documents
Group Documents let you store and share documents that are relevant to the
group. Group members can create their own documents and folders in the
common place, without having to create a file-sharing folder on a file server.
Additionally, you can add important information such as history (for archive
purposes), metadata, and work flow.
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To add Microsoft Office documents and other file types (including multimedia
files), choose Add New > Asset to drag-and-drop files to your documents
storage.

For more information on adding assets using different browsers, see Adding
Assets to the Intranet on page 97.
To create new HTML content, choose Add New > Content.
You can control a document's visibility during its construction, then later
distribute it to the rest of the Intranet as illustrated in the following example.
See Also: Adding Assets to the Intranet on page 97
Example: The Marketing group created a PowerPoint slide deck for use by the
Sales department. The Marketing group made many iterations of the slides and,
in some cases, contained information about a future release that has not been
approved to release to Sales. As long as the work is edited within the restricted
Marketing group, only group members can see the document. When the work is
completed and approved, group members can place a copy of the work into a
folder that is available to the rest of the Intranet users by choosing Distribute
from the menu. If necessary, the Marketing group then can continue to change
the file while the Sales group uses the version that was distributed.
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Group Calendar
Use the group calendar to schedule important dates for the group, such as
project milestones, demonstrations, and other significant meetings. Any group
member can add a calendar event.

The Upcoming Events widget displays a list of upcoming events from this
calendar. You can also share this calendar with your profile calendar. You can
even put members' calendars in a "mash-up" onto this calendar.
For information about a company calendar, see Setting Up a Company Calendar
on page 106

Group Discussion Board
The group discussion board lets you create forums and topics that are important
for your group. A group member can post and read discussion threads. You can
use all the functionality of normal discussion boards, including comment
moderation.
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Group Blog
Group blogs let you post important comments, instructions, procedures,
policies, or any type of communication. Blog functionality includes reply, edit,
post, RSS feeds, and subscribe.
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Group Photos
Group members can view and contribute photos and images in the group photos
area. You can tag each photo with information. A photo viewer and slide show
function is built in to this section. Photos stored within a restricted group can be
viewed only by group members.

Moderating a Group Message Board
You can moderate Group message boards similar to the way that you moderate
a personal message board. (See Moderating a Personal Message Board on page
150.)
To moderate a group message board, follow these steps.
1. From your profile page, click the Groups tab. All of your groups
appear in the middle of the screen.
2. Click the group that you want to edit.
3. Click Manage > Edit Group.
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4. The Edit Group Profile dialog appears.
5. On the Properties tab, check the Group MessageBoard Moderation box.
If you check the box, any group member must approve a post before
it appears on the group message board. Inappropriate posts may be
deleted before they appear on the message board (they will appear to
reviewers/approvers).

Adding Members to a Restricted Group
When creating a Community Group, you can determine if its membership policy
is open or restricted. An open policy lets anyone join the group. A restricted
policy requires the group's administrator to approve new members.

Inviting Users to Join a Group
To invite colleagues to join a group, follow these steps.
1. Log into the Ektron eIntranet as a CMS400.NET administrator or
administrator of the group you will ask others to join.
2. Choose My Intranet > Directory and click the Group Directory
tab.
3. Click the group to which you want to invite members. The group page
appears.
4. On the left, choose Manage > Invite Colleagues. The Invite Colleagues dialog box appears.
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5. Check the box next to the colleagues you want to invite to the
restricted group. (You can also specify email addresses on the Email
tab.)
6. Optionally modify the default message.
7. Click Send Invitations to send the message to the selected colleagues. Your colleagues will have to accept the invitation to appear in
the group.
The invited member navigates to My Intranet > My Profile > Groups
screen, then clicks the Groups I Have Been Invited to Join tab. The
invitation appears, and the user can accept or decline it.
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Joining a Restricted Group
To request joining a restricted group, follow these steps.
1. Choose My Intranet > Directory and click the Group Directory
tab.
2. Click the group you want to join. Its title is followed by (Restricted).
3. In the top left corner, click Join Group.

4. A CMS400.NET administrator or group administrator can approve or
decline this request in two places.
Ektron eIntranet group page > Members panel > Users
Requesting to Join this Group tab
CMS400.Net Workarea > Workarea > Settings > Community Management > View Community Group screen
> View Community Group Members Screen > Pending
tab.
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Enabling a Group Calendar and Forum
By default, all Community Groups delivered with Ektron eIntranet have a
calendar and a forum.

To create a new Community Group, choose Profile > Groups > Create
Group. You can decide whether to include a calendar, a forum, or both using
the check boxes circled in the following figure.
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Managing Group Photos
You can authorize Community Group members to access the right-click menu
options on the Group's Documents and Photos folders.

To enable these menu options for group members, follow these steps.
1. From your profile page, click the Groups tab. All of your groups
appear in the middle of the screen.
2. Click the group that you want to edit.
3. Click Manage > Edit Group.
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4. On the Properties tab, check the Allow member to manage
photo/workspace folders box.
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Editing My Profile
The My Profile page (shown in My Intranet > My Profile on page 52) in the My
Intranet area is where you enter information about you that lets you connect
and collaborate with other people in your organization.
You can modify the following items in My Profile:

Edit Profile
You can specify the following information on the Edit Profile tabs:
General
The following table and figure describe the information you can set. Fields with
a red asterisk (*) are required fields.
Field

Description

First name

Enter your first name.

Last Name

Enter your last name.

Password

Enter a password.

Confirm Password

Re-enter the same password.

E-Mail Address

Enter your email address.

Display Name

Enter the name you want to display to others, which can be a nickname or title.

User Language

Select from available languages.

Address

Enter the address (or just the zip code) of where you are located.

Latitude

This field is automatically determined by the address.

Longitude

This field is automatically determined by the address.

Avatar

Click on "Click to upload your Avatar" and choose an image file that you want to associate with your profile.

Profile Links

This field is automatically determined by your profile.
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Forum
The following table and figure describe the information you can set.
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Field

Description

Content and Forum
Editor

Choose eWebEdit400 or eWebEditPro.

Topics per Page

Select the number of topics you want to display on a page. If the number of available
topics exceeds the number you select, a scroll bar lets you see the additional topics.
For example, if you select 10, and there are 25 topics, you can scroll to see all the
topic, but only 10 will be displayed at one time.

Forum Signature

Click Edit to enter or modify an automatic signature that appears at the bottom of
each post you make to a forum topic.
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Tags
The following table and figure describe the information you can set.
Field

Description

Tags

Keywords that you can assign to content and library items, which allows for tag-based
searching. For example, you can add the tag EAC (Employee Activity Committee), and tag
content that is related to the EAC, so that people can search for the content using the EAC
tag.

Custom
The following table and figure describe the information you can set. Fields with
a red asterisk (*) are required fields.
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Field

Description

Moderate

Check the Moderate box to give this user privileges on a message board to approve and
delete posts. Regular users in a group message board can create and delete only their
own posts.

Features

Check the Features box to give the user an individual calendar. (There may be other features to grant, also.)
Choose from one of the following options:
Public - The user information is accessible by others on the eIntranet.

Private Profile

Private - The user information is not accessible by others on the eIntranet.
Colleagues - The user information is accessible only by people on the eIntranet that are connected as colleagues.
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Title

Enter the title of the user.

Department

Select the department to which this user belongs. The list contains any departments that
you have created.

Extension

Enter the user's telephone extension.

Phone

Enter the user's company telephone number.

Cell

Enter the user's cell phone number.

Desk

Enter the value that identifies the location of the desk (or cubicle, or office), if your office
identifies such things. This can be valuable in locating an employee on an office map.

Reports to:

Enter the name of the person to whom the user reports. This can be valuable for developing organizational charts.

Time Zone

Select the time zone where the user works.
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Activities
The following table and figure describe the information you can set. By default,
all activity is checked to display in the Activity Stream widget. By checking the
boxes, you can select criteria for the types of content you want to see when
colleagues or community groups create the content. You can also select
(publish) the types of content that you want colleagues to see under the My
Activities category.
Field

Description

SMS

A checked box indicates that the type of content will be sent to your cell phone Short Message Service (SMS).
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Field

Description

Activity Stream

A checked box indicates that the type of content will be displayed in the Activity Stream
widget on the eIntranet pages.

Email

A checked box indicates that the type of content will be sent to your Email address, which
is specified in the General tab of your profile.

Calendar
Use the personal calendar to schedule events. An administrator can combine
calendars. For information about combining Calendars, see Setting Up a
Company Calendar on page 106.
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Groups
Community groups are online places where people can discuss similar interests
(such as car racing, or work projects).
You can do the following in your Groups area:
View or hide the tags associated with your groups.
Create a new group by clicking Create Group. For information about
creating new groups, see Creating Community Groups on page 119.
View and approve requests to join the groups for which you are a moderator.
View the requests that you have made of other moderators to join
another group.
The following figure shows that the administrator is a member of the Marketing
and the Quality Assurance groups. The icon circled in the figure is a
moderator's link that takes you to the group page where you can see other
members of that group.

Colleagues
Colleagues are people with whom you connect and who are connected to you,
either through friendship or professional contact.
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You can do the following in your Colleagues area:
Display the people with whom you are connected.
View requests of people who want to connect to you as a colleague.
View the requests that you have made of others to connect as a colleague.

Blog
You can create your own web log (blog). Colleagues can follow your blog entries
automatically when you create them, when you make them public and your
colleagues have set up their profile to follow your blog. See Edit Profile on page
137 for information about setting up your profile.
You can do the following in the Blog area:
Add a new blog post.
Edit an existing post.
Delete an exiting post.
Create a permanent link to a specific blog post that you can access it
via the URL in the browser’s address bar. (Most blog pages show only
recent posts. After a post is moved off the blog’s front page, it is still
accessible via this link.)
Subscribe to RSS or Email notifications.
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View highlighted and clickable days on the calendar indicating when a
blog entry was posted.
View an automatic roll of blog entries.
View a list of archived blog entries.
View a list of blog post subjects.
View the most recent blog entries.

Creating Your Own Blog
To create a blog, follow these steps:
1. Open the access point ( ) and choose New Post (or click on Add
Post). A CMS400.NET editor appears.
2. Enter a title and content for your blog.
3. Click Publish ( ) when ready.
The following figure shows the CMS400.NET editor with "The Administrator's First Bog" ready to publish.

The following figure shows the published blog on the page.
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Dashboard
The Dashboard lets you personalize your own web view of the Ektron eIntranet.
To customize your dashboard, follow these steps:
1. Open the widget bar (

).

2. Drag and drop a widget onto your dashboard.
The following figure shows an open widget bar.
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To change the contents of a widget, click Edit ( ).
To dismiss the widget from the Dashboard, click Close ( ).

Documents
You can create or upload documents that you want to share with colleagues on
your Ektron eIntranet. You can create new HTML content, or upload document
assets (such as Word or PDF documents).
To create a new HTML document, follow these steps:
1. Open the Add New menu on the right side of the page and choose
Content, a CMS400.NET editor appears.
2. Enter a title and content, and any other data you want to associate
with the content, and click Publish ( ) when done.
To upload one or more document assets, follow these steps:
1. Open the Add New menu on the right side of the page and choose
Add Asset. The Add Document dialog box appears.
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2. Do one of the following methods:
Click on the Drag Drop tab, then drag one or more files from
a Windows Explorer to the dialog box.
Click the File Upload tab, then browse for a file and click
Upload when ready.

Favorites
You can create a list of often-used or important links on the Favorites page.
To add a favorite link, follow these steps:
1. Enter a URL in the field that is seeded with "http://".
2. Enter the title of the link that you want to display in your Favorites
list.
3. Click Add. The title appears in the list and you can click on it to display the specified URL.
You can also create folders to categorize your favorite links.
To add folders to My Favorites, follow these steps:
1. Right-click on the My Favorites folder and choose Add Folder.
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2. Enter the name of a subfolder in the Add Folder dialog box and click
Add.
The following figure shows two subfolders created called Work and Personal.

Photos
You can create and manage folders of photos.
To add a photo to your personal photo gallery, follow these steps:
1. Click Add Photo.
2. Optionally describe the one or more photos that you want to add then
click Next.
3. Depending on your browser, you can upload photos one at a time or
more than one file at a time. For information about your browser's
method, see Adding Assets to the Intranet on page 97.
You can also create folders to categorize your photographs.
To add folders to My Photos, follow these steps:
1. Right-click on the My Photos folder and choose Add Folder.
2. Enter the name of a subfolder in the Add Folder dialog box and click
Add.
The following figure shows the My Album subfolder with several
photos loaded.
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Moderating a Personal Message Board
On your profile page, the Public Messages tab shows your personal message
board. Any of your colleagues can post to it.

You can require the approval of these posts. This feature is known as
moderation of the message board.
If you enable moderation, a CMS400.NET or group administrator, or the
affected user must review and approve or deny posts before they are published.
During that review, you can delete inappropriate posts.
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To enable moderation, follow these steps.
1. From your profile page, click Edit Profile.

2. The Edit Profile dialog box appears.
3. On the Custom tab, check the Message Board box.
4. Click Save.
If you enable moderation, the affected user and administrators see any new
posts on the message board along with the previous posts. Approve and decline
buttons (enlarged below) let them publish or remove the new posts.
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Setting Up Permissions for the eIntranet
This section shows several examples of creating groups with specific
permissions. For complete information about setting permissions, see the
Ektron CMS400.NET Reference Manual.
By default, Ektron eIntranet has permission groups for the following groups:
Administrators (full control)
Department managers (control over department pages)
Department members (control over content creation in department
spaces)
Everyone (read-only in specific areas)
Content Approvers (a group of specified people to approve content
before it can be published to the Ektron eIntranet site)
To access the default permission group settings, enter the Workarea and choose
Settings > User Groups. The following figure shows the default user groups.

152

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Although you can set permissions on a per user basis, it is more effective to
establish groups that have specific permissions and then add or delete users
from the permission groups.
You can apply permissions to CMS400.NET folders, or content within a folder.
For example, you may want some users with specific permission to post
announcements, and another set of users to manage the content on the Human
Resources department page, which is maintained in the Human Resources
folder. The following figure shows the default permissions table for the toplevel Folders content.
To see this in the CMS400.NET workarea, follow these steps:
1. Open the Content tab.
2. Click on Folders.
3. Choose View > Properties
4. Click Permissions ( ). The permissions screen shows that the
Everyone group can do everything except overwrite the library.
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Folders inherit the properties of their parent folder unless you choose to break
the inheritance and modify the properties of a folder. For example, the default
Engineering page does not have the inheritance of the root folder (where the
Everyone group has many permissions). Instead, the Engineering page has 3
groups with different levels of permissions, as shown in the following figure.
To see this in CMS400.NET, follow these steps:
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1. Open the Content tab.
2. Click on Folders > Content > Deparments > Engineering.
3. Choose View > Properties
4. Click Permissions ( ). The permissions shows that the Everyone
group can do everything except overwrite the library.

On the department pages, the Everyone group has only Read-only and
Traverse Folder permissions. Department managers have complete control,
while department members can create content but cannot create collections or
folders and cannot restore deleted items.
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Setting Up Permissions for Creating Content
The default Ektron eIntranet lets any user in the Ektron eIntranet create content
and publish it immediately. If you want greater control of what people can do on
the Ektron eIntranet, you create groups, assign them specific permissions, and
assign users to one or more of the groups.
The following table shows the permissions that you can set.
You can create custom permission tables for each user group or individual
contributor.
Permission

Read Only

Description
View content.
Disable view of content.

Edit

Let the user edit content.
Do not let the user edit content.

Add

Let the user add new content.
Do not let the user add new content.

Delete

Let the user delete content.
Do not let the user delete content.

Restore

Let the user restore deleted content.
Do not let the user restore deleted content.

Let the user view the contents of the CMS400.NET library.
Library Read Only

Add Images

Do not let the user view the contents of the
CMS400.NET library.

Let the user add image files to the library.
Do not let the user add images to the library.

Add Files

Let the user add files to the library.
Do not let the user add files to the library.
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Permission

Add Hyperlinks

Description
Let the user add hyperlinks to HTML content.
Do not let the user add hyperlinks to HTML content.

Overwrite Library

Let the user overwrite images and files in the library.
Do not let the user overwrite images and files in the library.

Let the user create and manage CMS400.NET collections.
Collections

Add Folders

Do not let the user create and manage CMS400.NET
collections.

Let the user add folders to the CMS400.NET content hierarchy.
Do not let the user add folders to the CMS400.NET content
hierarchy.

Let the user modify folder properties in the CMS400.NET.
Edit Folders

Delete Folders

Do not let the user modify folder properties in the
CMS400.NET.

Let the user delete CMS400.NET folders.
Do not let the user delete CMS400.NET folders.

Traverse Folder

Let the user access the folder hierarchy.
Do not let the user access the folder hierarchy.

The following sections provide examples of creating permission groups. You
can create any number of groups for your company or organization.

Setting Up Permissions for a Group of
Administrators
By default, the Ektron eIntranet comes with an Administrators group that can
perform all tasks in the Workarea.
To add or delete users from the Administrators group, follow these steps:
1. In the CMS400.NET workarea, choose Settings > User Groups. The
existing user groups display including Administrators.
2. Click Administrators. A roster of administrator users appears.
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3. To add another user to the Administrator group:
a. Click Add User (
appears.

). A list of other CMS400.NET users

b. Check the box next to the user and click Save (
firm the operation.

) and con-

4. To delete a user from the Administrator group:
a. Click the username of the person you want to delete from
the group. That user's information appears.
b. Click Delete ( ) and confirm the deletion. The user is
removed from the Administrators group.

Setting Up Permissions for Department
Pages
Default departments and newly created groups have empty permission groups
automatically created.
To add users to each group, follow these steps:
1. Enter the Workarea and choose Settings > User Groups. The View
User Groups screen appears.
2. Click on Engineering Department Managers, for example. A
roster appears (initially empty).
3. Click Add User (

). A roster of all users appears.

4. Check the box next to each username that you want to have Department Manager permissions.
5. Click Save ( ) and confirm the operation. The users are added to the
Engineering Department Manager group roster with full control over
the Engineering department pages.
6. Click on Engineering Department and repeat steps 2 through 5,
selecting users that will have Engineering Department permissions.
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(Department members cannot create collections or folders and cannot
restore deleted items.)
By default, the Everyone group has only Read-only and Traverse Folder
permissions to each department.

Setting Up Permissions for a Group of
Read-Only Users
The following example shows you how to create full permissions for two people
and read-only permissions for everyone else for the Announcements folder
content, because you may want only the CEO and Admin to be able to create
announcements.
Follow these steps:
1. In the CMS400.NET workarea, choose Content > Folders
> Content > Company > Announcements.
2. Choose View > Properties.
3. Click Permissions (

). A roster of users and groups appears.

4. Uncheck Allow this object to inherit permissions, because you
are setting specific permissions to this folder (and any child folders).
5. Click Add Permissions (

). A roster of users appears.

6. Select users you want to have control over the contents of this folder.
In this example, choose admin and CEO and click Save ( ). The permission options appear.
7. Click Enable All on both tabs and then Save (
appear on the permission roster.

). The new users

8. Click on Everyone in the roster. The permissions options appear.
9. Uncheck all options except Read Only (standard tab) and Traverse
Folder (Advanced tab), then click Save ( ).

Setting Up an Approval Chain
You can ensure that content is reviewed and approved before it is published to
the Ektron eIntranet site by setting up approval chains. With an approval chain,
when content is submitted for publication, an approver gets notified by email of
the change. The approver reviews the change in the CMS400.NET workarea,
and can edit, approve, or decline the change. Declining sends the content
change back to the author; approving either passes it onto another approver in
the chain, or publishes the content if there are no other approvers.
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This section describes how to set up an approval chain so that content that is
created gets submitted for approval before it can be published on the Ektron
eIntranet site. The Ektron CMS400.NET Reference Manual has complete
information about workflows and approval chains.
Note: If you assign a user group to an approval chain, only one member of the group needs to
approve the content, not all members. Also, if a user appears in an approval chain twice (both as
a user and part of a user group), the approval chain skips the second approval because the user
has already approved the content.

Adding a Person or Group to a Folder's
Approval Chain
To view and add a person or group to a folder's approval chain, follow these
steps.
1. Select a folder from the left frame of the Workarea > Content tab.
2. Click View > Properties.
3. Click Permissions (
permissions.
4. Click Back (

) and uncheck Allow this object to inherit

).

5. Click View Approvals (
section of the screen.

). The approval chain appears in the lower

6. ClickAdd ( ). A roster of users appears. If the user you want as an
approver does not appear in the roster, add the user first to the permissions roster as described in Setting Up Permissions for Creating
Content on page 156.
7. Click on the user or group that you want to approve content when
changes are made to the folder and click OK to confirm your selection. You must select one user or group at a time, and each time the
selected user is added to the roster.

Selecting a Sequence of Approvals
To select a sequence of approvals, follow these steps.
1. Select a folder from the left frame of the Workarea.
2. Click View > Properties.
3. Click View Approvals ( ). (Be sure to choose a folder that has
more than one approver.)
4. Click Reorder Items (
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). An Approval Order screen appears.
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5. Click on one of the users or groups in the list and click the up ( ) or
down ( ) arrows at the right to change the order of the list. The user
or group at the top is the first approver, meaning that changed content must be approved through that person or group first, then the
next person or group, and so on.
6. Click Save (

) when the list is in the order you want.

The following figure shows an example where someone in the
Everyone group must review and approve a change to the
Announcements folder. If approved, then the admin must review and
approve it, and then the CEO finally reviews and approves the content
to be published.
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Viewing IT Requests
When the Request IT Help form is filled out and the Submit Request is clicked,
the form data is added to the CMS400.NET. To view submitted requests, follow
these steps.
1. Login as administrator.
2. Navigate to Employee Resources > Request IT Help. The
Request IT Help page appears.
3. Open the silver access point ( ) and choose Properties. The View
Forms "Request IT Help" screen appears in the
CMS400.NET Workarea.

4. Click Report ( ). The form changes for you to specify viewing criteria, such as start and end dates and so on.
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5. Click
Get Report. The requests display within the criteria that you
specified.
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Using the SmartDesktop to Manage
Your eIntranet
You can maintain it using your Workarea SmartDesktop. Measure web page
traffic, approve comments and content where necessary, or maintain content to
keep it current and up-to-date from this page.
The SmartDesktopcontains widgets that help you identify tasks to complete, or
view comments and content that you need to approve. The SmartDesktop uses
PageBuilder technology to help you rearrange or add/delete widgets.

The following table describes each of the blocks in the previous figure.
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Widget Used

Function

Content Currently Checked Out

This widget shows content that is currently in a checkedout state. This occurs when the author is editing the content or if the browswer is closed without publishing. Use
this to control the amount of space used to store unpublished content.

Content Review

This list shows content that has been rated and reviewed
by readers. Reviews can be moderated and approved
before they show on the content review associated to
content.

Content Awaiting Approval

Content listed here is awaiting approval before it is published. For more information about Approvals, see
Approval Chains in the Ektron CMS400.NET Reference
Manual.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Widget Used

Function

Forum Topics and Posts

This list shows new topics and posts that visitors have
added into a Discussion Board. For more information
about Discussion Boards and Forums, see the Ektron
CMS400.NET Reference Manual.

Customers

When new customers use eCommerce for the first time
they are listed here. For more information about eCommerce, see the Ektron CMS400.NET Reference Manual.

Content Flags

Content that has been flagged with any flags such as
"inappropriate" or "out of date" by visitors appears in this
list. For more information about content flags, see the
Ektron CMS400.NET Reference Manual.

Customizing the SmartDesktop
Using PageBuilder functionality, you can add, rearrange, or remove widgets on
your Smart Desktop. To learn more about customizing the SmartDesktop, see
How Customizing the Smart Desktop Works in the Ektron CMS400.NET
Reference Manual.
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Chapter 3

Using Widgets
Widgets are mini-applications that can provide either specific functionality
(calculators, search, and social bars, etc) or areas into which you can add
Ektron CMS400.NET content (content blocks, list summaries, collections, and so
on). You can drag and drop widgets onto a page using PageBuilder. To open the
widget bar from the PageBuilder menu, click on the up/down (
)
or down (
) controls.
The following table shows the eI_* widgets.
Name

Description

eI_ActivityStream Widget on page
171
Shows the activities of users and groups with whom you have connected using Community Settings within the Community Activities
section of the Web site.

eI_Blog Widget on page 174

Puts a blog on a page.

eI_Collection Widget on page 176

Shows a collection that is a list of content that you choose from the
content available in the CMS400.NET.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

167

Name

Description

eI_CommunityGroupMembers
Widget on page 178
Shows members in a community group. Additionally, if you are the
Group Administrator, you can add, remove or invite others to the
group.

eI_ContentBlock Widget on page
180

Shows any content on your web page that you want from your
CMS400.NET. Additionally, you can add the following options to the
content block.
Content Review with Ratings Stars.
Provide links for Add To Favorites, Email, and Print.
Comments submitted by logged in visitors.

eI_GroupSpaces Widget on page
183
Shows a list of groups. You can filter groups by selecting a taxonomy.
For example, you can show the groups associated with a department.

eI_Header Widget on page 184

Shows a header style with optional text.

eI_ListSummary Widget on page
185
Shows a list of content from a folder (and optionally its subfolders) on
your Web page.
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Name

Description

eI_Map Widget on page 188

Displays a map on your Web page.

eI_MicroMessaging Widget on page
190
Shows your status and activities similar to other micro-blogging services.

eI_News Widget on page 191

Displays a list of content ranked by most viewed, popularity ratings,
publish date (most recent).

eI_PhotoOfTheDay Widget on page
194

Shows an image file on your Web page.

eI_RecentBlogPosts Widget on
page 197

Shows the latest blog posts or content in a CMS400.NET folder.
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Name

Description

eI_Search Widget on page 199

Puts a search box on a PageBuilder page. As you type a search
string, results show below the Search button.

eI_SiteMap Widget on page 201
Shows the site map, which is created from the Folder Breadcrumb
settings in the Workarea. There are no properties to set in the Sitemap widget.

eI_TagCloud Widget on page 202
Shows the tags used on content, groups, and users and displays
their size according to the popularity of the term in the list. The more
a tag term is found, the larger the text. When you click on a term in
the tag cloud, the items associated with this tag term display.

eI_UpcomingEvents Widget on
page 203

Shows a list of scheduled calendar events.

eI_WebSearch Widget on page 205

Displays a search box for site, colleagues, groups, and activities.
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eI_ActivityStream Widget

Shows the activities of users and groups with whom you have connected using
Community Settings within the Community Activities section of the Web site,
similar to the following figure.

Properties
To change the properties, click Edit (

).
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Property

Value
Enter the ObjectID of the user or group whose activity you want to see in the
stream.

ObjectID

Note: If you select a user's ID, the Activity Stream displays the activities that this
user is watching; not only his activities.
Finding the ObjectID for a User belowFinding the ObjectID for a User below and
How to find the ObjectID for a Group below below for more information.

Feed Type

Select User or Group to specify the type of feed for the ObjectID you set.

Max Results

Enter the maximum number of activities to display in the Activity Stream. If more
than this number of activities is available, arrows appear at the bottom of the display, allowing the site visitor to see the older activities.

ReadMore
Link

Enter the URL address of the page to display when a site visitor clicks More
Activity at the bottom of the Activity Stream; usually to the page where more
activities are displayed. For example: http://myhost/news.aspx?id=1

Finding the ObjectID for a User
To set the ObjectID of an Activity Stream widget that displays a user, follow
these steps.
1. Log in to the Ektron CMS400.Net Workarea.
2. Go to Settings >Users.
3. Click the user to display in the widget.
4. The ID appears as shown below.

How to find the ObjectID for a Group
To set the ObjectID of an Activity Stream widget that displays a group, follow
these steps.
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1. Log in to the Ektron CMS400.Net Workarea.
2. Go to Settings > Community Management > Community
Groups.
3. The ID for each group appears on the screen, as shown below.
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eI_Blog Widget

Puts a blog on a page, and looks similar to the following figure:

Blogs are created in folders within the Ektron CMS400.NET Workarea.
To change the properties, click Edit (

).

Properties Tab
Property

Value

Blog ID

Enter the ID number of the blog . If you do not know the ID, use the Folder tab to
navigate to the blog to find the Blog ID number.

CSS Path

Enter the path and name of the CSS file that defines the "skin" you wish to use
for the blog. Provide the path starting at the site root. For example: "widgets/ei_
Blog/Blogs.css".

Folder Tab
Use the Folder tab to select the blog folder.
To select a folder or content, do the following:
1. Click the Folder tab.
2. Navigate to the folder you want and click it.
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3. If the View Results panel is showing, click the content you want.
4. Click Save.
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eI_Collection Widget

Shows a collection that is a list of content that you choose from the content
available in the CMS400.NET. It looks similar to the following figure.

Authorized users create and edit collections in the Workarea.
To change the properties, click Edit (

).

Properties Tab
Set the properties as shown in the following table.
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Property

Value

CollectionID

Enter the ID of the collection you want to display.

Page Size

Enter the number of items to list on a single page.

Teaser

Check to show the content summary text with the content title.

Enable Paging

Check to see more content titles with forward and backward buttons,
when more items are in a collection than were specified in the Page
Size parameter.
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Property

Value
Enter the menu item text to add more content. For example, if you
enter "Add Quick Reference" it displays as follows in the editor menu.

Add Text

SelTaxonomyID

Enter the ID of the taxonomy that is assigned to the new content when
Add Items is chosen.

DisplaySelectedContent

Check to show content in this widget location when the site visitor
selects the content link from the collection. This overrides the quick link
normally associated to the content.

Enable Header

Check to show header text above the widget.

Header

Enter text for the Header. Check the Enable Header property box to
show this text. If no text is entered into the Header property, the collection name shows.
Select one of the following to determine how the content information is
displayed.
BulletedList - Displays the content titles as a
bulleted list.

XSLT

ecmNavigation - Displays the titles of the content.
ecmTeaser - Displays the titles and summary of the
content.
ecmHtml - Displays the entire content.
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eI_CommunityGroupMembers Widget

Shows members in a community group. Additionally, if you are the Group
Administrator, you can add, remove or invite others to the group. It looks like
this when you are logged in.

When you are logged in, you can do the following.
Click Members to see the list of current members in the group.
Click Pending Members to see the list of people waiting for approval to
join this group.
Click Invitations to see the list of people who have been invited to join
this group.
Check the box next to a member and click Remove to delete that person from the group.
To change the properties, click Edit (

).

Properties
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Property

Value

Group ID

Enter the ID number of the Group you want to display.
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Property

Value

Header Text

Enter any text string to show a colored bar with text above the widget. If you
leave this blank, no text or colored bar shows on the page. Text for the header is
placed inside an <h3> tag and adopts the same styles as the column in which it is
placed. (Optional)
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eI_ContentBlock Widget

Shows any content on your web page that you want from your CMS400.NET
including html, text, documents and digital media. You can set the content block
widget to show a specified content id or you can set the dynamic parameter so
that the content dynamically changes at any time the parameter is passed.
You also can add the following options to the content block.
Content Review with Ratings Stars.
Provide links for Add To Favorites, Email, and Print.
Comments submitted by logged in visitors.
The content block looks similar to the following figure.

To change the properties, click Edit (

).

Fields
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Field

Description

Filtered by:

Choose Content, Form, or Multimedia and then click View
Results on the bottom left of the dialog box to see the content items
in the selected type.
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Field

Description

View Result

Click to display contents of the selected folder. Hover over a content
item so see a summary of the content. You can filter the content as
described in the previous table entry.

Cancel Button

Click to dismiss the dialog box without adding content.

Save button

Click to save the changes you made and dismiss the dialog box.

New button

Click to create new content (rather than selecting existing content).

Properties Tab
Property

Value

Show Social
Bar

Check to show links for Add To Favorites, Email and Print.

Show Content Review

Check to include a Star Rating bar next to the content title. Ratings by visitors
indicate how they feel about the content. (Highly rated content attracts more
readers.)

Show Content Title

Check to show the title text. This parameter is superceded if the Header Text
has a value.

Show Message Board

Check to allow comments on this content.

Header Text

Enter text to replace the title of the content. If this is blank, the content's title will
show.

Read More
Text

Enter the string for the Read More hyperlink set in the next property. For example: "Read More..."

Read More
Hyperlink

Enter the hyperlink used for the Read More Text set in the previous property.
For example: "Content.aspx?id=168".

Dynamic
Parameter

Enter any text to pass content id numbers to this widget. When you set this to
"id", the widget shows the content number equated to it. For example, if the
URL is http://mysite/default.aspx?id=30 then content number 30 shows.

The Folder, Taxonomy, and Search tabs help you find the content you want to
use in this widget.
Folder Tab
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To select a folder or content, do the following:
1. Click the Folder tab.
2. Navigate to the folder you want and click it.
3. If the View Results panel is showing, click the content you want.
4. Click Save.
Taxonomy Tab
Select the Taxonomy Category to find the content to add to this widget.
To select a Category or Content, do the following:
1. Click the Taxonomy tab.
2. Navigate to the lowest category branch that you want to use.
3. To select specific content, click the desired content in the View Results
panel.
4. Click Save.
Search Tab
To search for Content, do the following:
1. Click the Search tab.
2. Set the Filter By dropdown to Content, Forms, Multimedia.
3. Enter the Search Terms and press Enter.
4. Click the desired content in the View Results panel and click Save.
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eI_GroupSpaces Widget

Shows a list of groups. You can filter groups by selecting a taxonomy. For
example, you can show the groups associated with a department, similar to the
ones shown in the following figure.

To change the properties, click Edit (

).

Properties Tab
Property

Value

Header Text

Enter the text that displays above the group spaces. If left blank, a blank header
shows.

Taxonomy Tab
To select a Taxonomy category, do the following:
1. Click the Taxonomy tab.
2. Navigate to the lowest category branch that you want to use and click
Save. Branches beneath your selection are included also.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

183

eI_Header Widget

Shows a header style with optional text similar to the following example.

The style used by the header uses the following tag in the eIntranet web site.

<h3 class=”headerContent”>

To change the properties, click Edit (

).

Properties
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Property

Value

Header Text

Enter the text that you want to show in the header.
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eI_ListSummary Widget

Shows a list of content from a folder (and optionally its subfolders) on your
Web page similar to the following figure.

To change the properties, click Edit (

).

Properties Tab
Property

Value

Folder ID

Enter the ID of the folder that contains the items appearing in the list. Set the
Recursive property to include subfolders under this folder.
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Property

Value

Enable
Header

Check to show header text above the eI_ListSummary widget. If no text is
entered into the Header property, the folder name shows.

Header

Enter text for the header. Check the Enable Header property box to show this
text.
Select one of the following to determine how the content information displays.
BulletedList - Displays the content titles as a bulleted list.
CalendarEvents - Displays a list of scheduled events.

XSLT
ecmNavigation - Displays the titles of the content.
ecmTeaser - Displays the titles and summary of the content.
ecmHtml - Displays each content in the list summary.

Recursive

Check to include content in subfolders under the folder indicated by the FolderID property.

Enable Paging

Check to show links to page forward or backward through the content list. The
amount of content shown in each page is set by the Items Per Page property.

Enable Scrolling

Check to enable automatic scrolling, which animates the list by scrolling from top
to bottom then repeats indefinitely.

Items Per
Page

Enter the number of content items you want to display on a page. If blank, page
forward/backward buttons do not show.

Include Icons

Check to show icons that represent each content item's type in the eI_ListSummary.

Sort Order

Choose Ascending (A-Z; first-last) or Descending (Z-A; last-first).
Choose one of the following options.
Title - Sorts by the title of the content.
DateModified - Sorts by the date the content was last edited.

Order By

DateCreated - Sorts by the date the content was first
published.
Last Editor's First Name - Sorts by the first name of the
person who last published the content.
Last Editor's Last Name - Sorts by the last name of the
person who last published the content.

186

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Property

Value
Choose the type of content to display in the ListSummary.
Content - Displays only content.

Content Type

Discussion Topic - Displays only discussion topics.
Multimedia - Displays only multimedia file types.
AllTypes - Displays all types of content.
Enter the text used in the editor's menu to add more content. For example: if
you enter "Add Quick Reference" it appears in the Edit menu as shown.

Add Text

Taxonomy ID

Enter the taxonomy ID with which content is associated when you choose Add
Items.

Display Content

Check to retrieve and display HTML content for each item in the ListSummary.

Read More
Link Text

Enter text for the Read More Hyperlink set in the next property. For example:
"Read More..."

Read More
HyperLink

Enter the hyperlink used for the Read More Text set in the previous property.
For example: "Content.aspx?id=168".
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eI_Map Widget

Displays a map on your Web page that looks similar to the following figure.

To change the properties, click Edit (

).

Properties Tab
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Property

Value

Folder ID

Enter the ID number of the folder that contains the content to show on the map.
Note: The content must have Map Metadata (Address etc.) before it shows on
the map.

Enable
Header

Check to show Header Text above the Map Widget.
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Property

Value

Header

Enter text for the Header. If no text is entered, the folder name shows. Check
the Enable Header property box to show this text.

To select a folder or content, do the following:
1. Click the Folder tab.
2. Navigate to the folder you want and click it.
3. If the View Results panel is showing, click the content you want.
4. Click Save.
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eI_MicroMessaging Widget

Shows your status and activities similar to other micro-blogging services, and
looks similar to the following figure.

There are no properties for this widget. Messages are automatically associated
to a login.
The eI_MicroMessaging widget lets you do the following:
display your own micro-messages
submit new micro-messages. For example, update your status.
search all micro-messages.
When a colleague views another colleague's micro-messages, she sees the
other colleague's messages, and the messages of people that the two
colleagues have in common, but she cannot search the messages of or update
the other colleague's status.
To use micro-messaging, do the following.
1. Enter an answer to the question "What are you working on?"
2. Click Update Status.
Your status message list updates. If you have notifications turned on, then
colleagues see the status message too.
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eI_News Widget

Displays a list of content ranked by most viewed, popularity ratings, publish
date (most recent), and looks similar to the following figure.

Properties Tab
Property

Value

Folder ID

Enter the ID of the folder that contains the items to appear in the list summary.
Set the Recursive property to include subfolders under this folder.

Enable
Header

Check to show header text above the list summary widget. If no text is entered
into the Header property, the folder name shows.

Header

Enter text for the header. Check the Enable Header property box to show this
text.
Select one of the following to determine how the content information displays.
BulletedList - Displays the content titles as a bulleted list.
CalendarEvents - Displays a list of scheduled events.

XSLT
ecmNavigation - Displays the titles of the content.
ecmTeaser - Displays the titles and summary of the content.
ecmHtml - Displays each content in the list summary.
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Property

Value

Recursive

Check to include content in subfolders under the folder indicated by the FolderID property.

Enable Paging

Check to show links to page forward or backward through the content list. The
amount of content shown in each page is set by the Items Per Page property.

Enable Scrolling

Check to enable automatic scrolling, which animates the list by scrolling from top
to bottom then repeats indefinitely.

Items Per
Page

Enter the number of content items you want to display on a page. If blank, page
forward/backward buttons do not show.

Include Icons

Check to show icons that represent each content item's type in the ListSummary.

Sort Order

Choose Ascending (A-Z; first-last) orDescending (Z-A; last-first).
Choose one of the following options.
Title - Sorts by the title of the content.
DateModified - Sorts by the date the content was last edited.

Order By

DateCreated - Sorts by the date the content was first
published.
Last Editor's First Name - Sorts by the first name of the
person who last published the content.
Last Editor's Last Name - Sorts by the last name of the
person who last published the content.
Enter the text used in the editor's menu to add more content. For example: if
you enter "Add Quick Reference" it appears in the Edit menu as shown.

Add Text
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Taxonomy ID

Enter the taxonomy ID with which content is associated when you choose Add
Items.

Display Content

Check to retrieve and display content for each block in the list summary.

Ektron eIntranet
Document Rev. 1.1,1 (Sep. 2011)

Property

Value

Read More
Link Text

Enter text for the Read More Hyperlink set in the next property. For example:
"Read More..."

Read More
HyperLink

Enter the hyperlink used for the Read More Text set in the previous property.
For example: "Content.aspx?id=168".
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eI_PhotoOfTheDay Widget

Shows an image file on your Web page similar to the following figure.

Choose an image file asset from the CMS400.NET Workarea folders.
The image width automatically resizes to 100% of the available space for the
widget and maintains the aspect ratio. A visitor can choose to print or email the
photo.
To change the properties, click Edit (

).

Properties Tab
Property

Value
Enter text to show a colored bar with text above the Photo of the Day. If you
leave this blank, no text or colored bar shows appears.

Header Text
Header text is placed inside an <h3> tag and adopts the same styles as the
column in which it is placed. (Optional)

Hyperlink
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If desired, enter the URL of a page that displays if a site visitor clicks the Photo of
the Day. For example, you could link to a photo gallery page for people to
peruse.
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Property

Value

Path to Photo
Gallery

Enter the URL of the page that contains the photo gallery.

Enable Caption

Check to show a caption under the Photo of the Day.

Caption

Enter text to show as a caption under the Photo of the Day. If this is blank and
Enable Caption is checked, the image file name displays.

Use Folders, Taxonomy, or Search tabs to select the image file. Choose the
image file to show from the View Results section.
Folder Tab
To select a folder or content, do the following:
1. Click the Folder tab.
2. Navigate to the folder you want and click it.
3. If the View Results panel is showing, click the content you want.
4. Click Save.
Taxonomy Tab
To select a Category or Content, do the following:
1. Click the Taxonomy tab.
2. Navigate to the lowest category branch that you want to use.
3. To select specific content, click the desired content in the View
Results panel.
4. Click Save.
Search Tab
To search for Content, do the following:
1. Click the Search tab.
2. Set the Filter By dropdown to Content, Forms, Multimedia.
3. Enter the Search Terms and press Enter.
4. Click the desired content in the View Results panel and click Save.
Click Save when done.
Firefox Browser Extension
For Firefox, you may be prompted to install the Ektron Drag Drop Extension.
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eI_RecentBlogPosts Widget

Shows the latest blog posts or content in a folder, and looks similar to the
following figure.

To change the properties, click Edit (

).

Properties Tab
Property

Values

Heading

Enter text to show a colored bar with text above the content block. If you leave this blank, no text or colored bar will
show above the content block. Text for the header is placed inside an <h3> tag and adopts the same styles as the column in which it is placed. (Optional)
Enter menu text. For example: if you enter "Add New Post" it appears in the edit menu as shown.

Add Text

Folder ID

Enter the folder ID that contains the content or blog posts.

EnablePaging

Check to show links to page forward or backward through the content list. The amount of content shown in each
page is set by the Results Per Page property.

Results Per
Page

Enter the number of content items to display in this widget. If blank, page forward/backward buttons do not show.

Direction

Choose Ascending (A-Z; first-last) or Descending (Z-A; last-first).
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Property

Values
Choose one of the following options, sorted by the Direction property.
Title - Order by the title of the content.
DateModified - Order by the date the content was last edited.

Order Key
DateCreated - Order by the date the content was first published.
Last Editor's First Name - Order by the first name of the person who last published the content.
Last Editor's Last Name - Order by the last name of the person who last published the content.
Read More
HyperLink
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Enter the hyperlink used for the Read More Text set in the previous property. For example: "Content.aspx?id=168".
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eI_Search Widget

Puts a search box (as shown in the following figure) on a PageBuilder page.
After the page is published, as a site visitor types a search string, results that
match the user's entry show below the search box.

Note: You cannot use the Search widget while the page is being edited.
To change the properties, click Edit (

).

Properties Tab
Property

Value
Select the type of content to display in the results.
Only HTML (Content and Forms) - Content placed inside the
Workarea content folders but it does not include documents from
the Document Management System (DMS).

Search Type

Only Multimedia - Content with extensions such as .flv, .mp3,
.jpg, and so on.
Only Community Groups - Only content within groups that the
visitor is authorized to see. This includes public groups and groups
in which they have become a member.
All Files - All content within the Ektron CMS400.NET Web site.

Taxonomy Tab
Select the Category to limit the search criteria.
To select a Category or Content, do the following:
1. Click the Taxonomy tab.
2. Navigate to the lowest category branch that you want to use.
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3. To select specific content, click the desired content in the View Results
panel.
4. Click Save.
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eI_SiteMap Widget

Shows the site map, which is created from the Folder Breadcrumb settings in
the Workarea. There are no properties to set in the SiteMap widget. A site map
looks similar to the following figure.
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eI_TagCloud Widget
Shows the tags used on content, groups, and users and displays
their size according to the popularity of the term in the list. The
more a tag term is found, the larger the text. When you click on a
term in the tag cloud, the items associated with this tag term
display.
There are no properties to set in the Tag Cloud widget. It looks similar to the
following figure.
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eI_UpcomingEvents Widget

Shows a list of scheduled calendar events, similar to the following figure.

To change the properties, click Edit (

).

Properties Tab
Property

Values

Folder ID

Enter the folder ID that contains the events you want to show in the list.

Enable
Header

Check to show the header above the widget.

Header

Enter text to show a colored bar with text above the Search box. If you leave this
blank, no text or colored bar shows above the search box. Text for the header is
placed inside an <h3> tag and adopts the same styles as the column in which it's
placed. (Optional)

Enable Paging

Check to show links to page forward or backward through the content list. The
amount of content shown in each page is set by the Items Per Page property.
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Property

Values

Items Per
Page

Enter the number of content items you want to display on a page. If blank, page
forward/backward buttons do not show.

Read More
Link text

Enter the string for the Read More Hyperlink set in the next property. For example: "Read More..."

Read More
HyperLink

Enter the hyperlink used for the Read More Link Text property. For example:
"Events.aspx"

Folder Tab
Use the Folder Tab to browse the content folders to set the Folder ID property.
To select a folder or content, do the following:
1. Click the Folder tab.
2. Navigate to the folder you want and click it.
3. If the View Results panel is showing, click the content you want.
4. Click Save.
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eI_WebSearch Widget

Displays a search box for site, colleagues, groups, and activities, and looks
similar to the following figure.
Note: You cannot place more than one Web Search widget on the same
PageBuilder page.

Each tab has a Search button, plus some have filters to narrow the search
criteria.

Search Site
1. Select Basic Search or Advanced Search.
2. Enter the search term.
3. Select the search type from the choices shown below.

4. Click Search.
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Search Colleagues

1. Select the type of user information you want to search for from the
drop down list, as shown.

2. Enter the search term.
3. You can add a filter or add a category.
The following example shows the results when you add a category and select
"marketing".
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Search Groups

1. Select the type of group information you want to search for from the
drop down list, as shown.

2. Enter the search term.
3. You can add a filter or add a category.
4. Click Search.

Search Activity

1. Enter the term that can be found in Activity Stream messages.
2. Click Search.
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APPENDIX 4

Getting Support
The following resources are available to help you with your Ektron eIntranet
project.

Locations and Phone Numbers
Location

Phone

Worldwide Headquarters
542 Amherst Street (Route 101A)
Nashua, NH 03063 USA

1-866-4-EKTRON

SUPPORT

1-603-594-0249 x7002

Canada
675 Cochrane Drive East Tower, 6th Floor
Markham, Ontario L3R 0B8

905-530-2211

United Kingdom
Sienna Court,
The Broadway,
Maidenhead
SL6 1NJ
UK

+44 (0) 1628 509 040

Australia
Level 3
61 York Street
Sydney NSW 2000
Australia

+61 2 9248 7222

Singapore
81 Anson Rd.
Suite 8.35, Level 8
Singapore 079908

+61 2 9248 7206

603 -594-0249

For additional contact information, see http://www.ektron.com/contact/.
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ektron.com
The web home of Ektron has useful information, including additional contact
information and services. You can find product documentation in the
documentation section (http://www.ektron.com/documentation/).

Synergy
Ektron's investment in you never stops. We are always listening to our
customers, and the annual Synergy Customer Conference is a great way for us
to learn what is important to you. The conference also is a great way for you to
learn more about using your Ektron CMS400.NET.
For more information, see our web page: http://synergy.ektron.com.

Local User Groups
Every Spring, Ektron management meets with Ektron users in as many cities as
possible to bring the latest news and products from Ektron. We listen to what is
important to you. The Local User Group Sessions (LUGS) receive positive
ratings year after year.

The Dev Center (dev.ektron.com)
The Ektron DevCenter includes resources to assist our customers. If you are
looking for a solution to a specific problem or just seeing what you might be
able to do with CMS400.NET, you can find it here. You also can find Webinars
that offer help and insight to many of the features of Ektron CMS400.NET.
The Dev Center also has a product forum where you can pose questions,
provide answers to other users, and share tips on how to use Ektron eIntranet
more effectively.
See the Dev Center at http://dev.ektron.com.

Professional Services
Ektron has a complete services infrastructure, in addition to providing you with
a powerful CMS platform, to ensure your project’s success. Each service
engagement is unique and customized to meet your specific needs. Ektron
assures predictable results using comprehensive Web Project Methodology and
RAMP strategy (Risk mitigation, Adoptability, Maintainability, Performance) to
guide every project.
Click here to see more about Ektron Professional Services.
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Best Practice Services
Ektron’s Best Practice Services (BPS) gives you access to Ektron solution
engineers who are intimately familiar with your web project goals and have the
expertise to make them a reality using Ektron CMS400.NET.

Implementation
By engaging Ektron to implement all or part of your web site project, expert
application engineers follow our proven Ektron Methodology to ensure the
success of the project.

Hosting
Ektron offers a complete line of web site hosting packages to fit the needs of
each deployment, from enterprise-level to small and medium-sized businesses.
Ektron Hosting’s secure facility ensures that your business-critical applications
are online and secure, giving you peace of mind.
For more information about Ektron Hosting, see
http://www.ektron.com/hosting.

Training
Ektron’s training courses ensure your web project’s success by providing the
right level of training to your team at the right stage of your web project’s
lifecycle.
Call your Ektron Customer Support Representative to schedule your class.
For more information about Ektron Training, see
http://www.ektron.com/services/training/.
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Index

Index
A
activities tab, personal profile
141
activity stream
appearance on activity timeline
55
widget
changing user group whose activ- 72
ities appear
changing user whose activities
71
appear
customizing
70
activity stream widget
171
activity timeline
55
all day option
web calendars
109
announcements
making
80
page
44
approval chain
159-160
assets
adding to eIntranet
97
adding to personal profile
147

B
blog posts
recent
widget
blogs
CEO
adding entry
link on personal profile
widget
building maps page

D
197
46
78
144-145
174
37

C
calendars
adding events
community group
enabling
community group, adding
personal
personal, adding
recurring events
system
adding to widget
introduction
sample
types
widget
editing
placing on Web Page
CEO blog
adding entry
colleagues
link on personal profile
collection widget

community group
calendars
enabling
134
calendars, adding
115
creating
119
dashboard
126
forum, enabling
134
group activity area of screen
125
group members area
125
members widget
178
message board
moderating
150
viewing
125
restricted membership
inviting users to join
131
requesting to join
133
users
documents
135
photos
135
viewing
119
company calendar page
48
company news page
41
conference room calendar page
25
content
block widget
180
content, permissions
See permissions
custom tab
personal profile
139

dashboard
community group, customizing
personal
department pages
permissions, adding users
directory page
documents
adding to eIntranet
personal profile

126
146
158
57
97
147

E
108
134
115
142
116
110
114
106
107
112
113
107
46
78
143, 162
176

eI_RecentBlogPosts widget
employee handbook page
events
calendar, adding
upcoming, widget

group members area
community group screen
group spaces widget

H
handbook,employee page
header widget
home page
editing
tour

F

31
184
64
4

I
inheritance
of permissions from parent folder

154

L
list summary widget
editing
listsummary widget
logo, changing

83
185
64

M
map widget
membership
community group
restricted
message board
group
moderating
viewing
personal
moderating
messages from management page
micro-messaging widget
moderating
group message board
my messages
my profile

188

130

130
125
150
43
190
130
55
52

N

78
31
108
203

125
183

news
widget
news items
displaying
newsletters page

191
83
33

O

favorites
on personal profile
forums
community group
enabling
page, default

148
office locations page
134
29

G
gallery
photo
See photos, adding to gallery
group activity area
community group
125

35

P
page
adding new
creating navigation to
Pagebuilder
page
adding new
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94

Index-1

permissions
content
administrators
adding or deleting
157
creating read-only users
159
department pages
adding users
158
inheritance from parent folder 154
managing
156
overview
154
phone book
content block, changing content of 75
photo gallery page
50
managing photos
51
photo of the day
widget
changing image
67
photos
adding on the photo gallery page
51
adding to gallery
101
adding to personal profile
149
managing on the photo gallery page 51
profile
personal
activities tab
141
blog link
144-145
calendars link
142
colleagues link
143, 162
custom tab
139
dashboard link
146
documents link
147
editing
140
favorites link
148
forum tab
138
general tab
137
groups link
143
photos link
149
tags tab
139

Q
quick reference collection widget
adding a link

74

R
read-only users
permissions
content
recent blog posts widget
recurring events
adding to calendar
request IT help page
restricted membership
community group
inviting users to join
requesting to join

159
197
110
26
130
131
133

S
search
page
widget
site map
page

Index-2

59
199

widget
201
system calendar See calendars, system

T
tag cloud
page
widget
tags
tab
personal profile
twitter feed widget
setting up

60
202

139
86

U
upcoming events widget
203
adding event
65
changing calendar
65
user calendar See calendars, personal

W
web search widget
205
WebCalendar
See calendars,
widget
widget
welcome guide page
22
widgets
activity stream
171
Activity Stream
changing user group whose activ- 72
ities appear
changing user whose activities
71
appear
customizing
70
blog
174
calendar
default
113
collection
176
community group members
178
content block
180
eI_RecentBlogPosts
adding entries
78
group spaces
183
header
184
listsummary
185
map
188
micro-messaging
190
news
191
photo of the day
changing image
67
quick reference collection
adding a link
74
recent blog posts
197
search
199
sitemap
201
tag cloud
202
twitter feed
setting up
86
upcoming events
65, 203
changing calendar
65
web search
205
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